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FOREWORD

FOREWORD

The concepts, methods, and examples presented in this text are for illustrative and
educational purposes only, and are not intended to be exhaustive or to apply to any
particular engineering problem or design.

This material is a compilation of data and figures from many sources.
Engineering Technology Associates, Inc. assumes no liability or responsibility to

any person or company for direct or indirect damages resulting from the use of any
information contained herein.
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OVERVIEW

OVERVIEW

The eta/DYNAFORM software package consists of four programs. These
programs represent the pre-processor, solver and post-processor. They are:
eta/DYNAFORM, eta/Job Submit, eta/POST and eta/3DPlayer.

eta/DYNAFORM is the pre-processor portion of the software package. Sheet metal
forming models are constructed using this software. It includes VDA and IGES
translators for importing line data and a complete array of tools for altering or
constructing line data and meshing it.

LS-DYNA is the software package’s solver. etay/DYNAFORM has a complete
LS-DYNA interface allowing the user to run LS-DYNA from eta/DYNAFORM.

eta/POST and eta/GRAPH are the post-processing portions of the package. These
programs are used to post-process the LS-DYNA result files from the analysis.
eta/POST creates contour, deformation, FLD, and stress plots and animations with
the result files. etadGRAPH contains functions for graphically interpreting the
same results.

eta/POST
(post-processor)

\ 4

eta/DYNAFORM eta/Job Submit
(pre-processor) (LS-DYNA solver) Ve ~

eta/3DPlayer

(post-processor)

\ 4

Figure 1: Components of eta/DYNAFORM solution package.

Each of the software components has its own manual which should be referenced
for further information on running these programs. These manuals are:

eta/DYNAFORM Application
Manual

eta/DYNAFORM User’s
Manual

LS-DYNA User’'s Manual

eta/POST User’'s Manual

A comprehensive training manual for using the
eta/DYNAFORM software package for various
applications.

A reference guide to the functions contained in the
eta/DYNAFORM program (pre-processor).

A reference guide to the LS-DYNA program
(solver).

A reference guide to the functions contained in the
eta/POST program and eta/GRAPH program
(post-processor).
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INTRODUCTION

INTRODUCTION

Welcome to the eta/DYNAFORM version 5.5 Application Manual. The
eta/DYNAFORM version 5.5 is the unified version of the etay/DYNAFORM-PC
and UNIX platforms. This manual is meant to give the user a basic understanding
of finite element modeling for forming analysis, as well as displaying the forming
results. It is by no means an exhaustive study of the simulation techniques and
capabilities of eta/DYNAFORM. For more detailed study of eta/DYNAFORM, the
user is urged to attend an eta/DYNAFORM training seminar.

This manual details a step-by-step sheet mental forming simulation process through
Auto-Setup interface process. Users should take the time to learn setup process as
each has inherent benefits and limitations.

The following table outlines the major differences of the traditional setup, the Quick
Setup, and the Auto Setup procedure.

TRADITIONAL SETUP QUICK SETUP AUTO SETUP
Manual interface can duplicate . There are some inner templates that
. . . Automated interface .
any tooling configuration: pads, | . . o enables user to setup all kinds of
. limits flexibility .
multiple tools, etc. operation.
. . Reduces modeling | Reduces setup time and reduces the
Requires more setup time . L .
setup time possibility of make mistake
Manual definition of travel | Automated travel | Automated travel curves and manual
curves curves definition curve
Geometrical Offset and Contact Both Contact Offset and
Contact Offset .
Offset Geometrical Offset

The exercises provided in the application manual are listed as the following:

Single Action Draw: single action/contact offset/copy elements.
Double Action Draw: double action/LCS/symmetry.

Tubular Hydroforming: hydroforming/working direction.
Gravity Loading: gravity loading.

Single Action Tailor Welded Blank: weld-forming/mesh physical
offset/simple multi-stage.

Springback Analysis: springback.

Sheet Hydroforming: double action/hydro-forming/draw bead.

a r w N E

Note: This manual is intended for the application of all eta/DYNAFORM platforms. Platform
interfaces may vary dightly due to different operating system requirements. This may cause some
minor visual discrepancies in the interface screen shots and your version of eta/DYNAFORM
that should be ignored.
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Example 1. Single Action
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Single Action

DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5

For workstation/Linux users, enter the command “df55” (default) from a UNIX shell.
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created.

The example only demonstrates the application of AutoSetup, hence you open the
database that has been created.

Open the database

1. From the menu bar, select File>Open... to open the OPEN FILE dialog
box, as illustrated in Figure 1.1.

Open @
Look in: |15 of | £ B~
E Double_ackion_hydro.df
4 gravity_|oading. df
My Recent single_action. df
Docurnents
(T
Desktop
My Documents

by Computer

My Metwork  File namme: |single_ac:tin:-n.df j Oz _|

Flaces
Filez af type: | databaze [*.df] ﬂ Cancel

Figure 1.1  Open file dialog box
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Single Action

2. Go to the training input files located in the CD provided along with the
eta/DYNAFORM installation, and open the data file named single_action.df.
The parts, as illustrated in Figure 1.2, is displayed in isometric view on the
display area.

2,
X
X e
e L ah as)
e e B R
PR e S S RO e B L e
e
D S Lo e LA T T S A S S
I S S S S o S S S A e St A (S SO
ey
e S T e e e
T e e S G et S g i g S
B e B S Sl SR SO S A ST e S
A S AN e e T e
S L e e
S S A S e e
e

X Y
ETA/DYNAFORN

Figure 1.2  lllustration of fender model

Note: The Icons bar may appear different depending on type of platform. Other
functions on the Toolbar are further discussed in next section. You can also
refer to the eta/DYNAFORM User’s Manual for information about the
Toolbar functions.

Database Unit

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.
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Single Action

AUTO SETUP

Prior to entering AUTOSETUP interface, upper/lower tool meshes are required. The
other operation can be carried out in AutoSetup interface, such as PHYSICAL
OFFSET of element, selection of CONTACT OFFSET. As illustrated in Figure 1.3,
you can select AUTOSETUP option from the SETUP menu to display the
AUTOSETUP interface.

File Parts Preprocess | DFE  BsE Tools Option  Utilities  Wiew .

Gravity Loading
Draw Die
Spring Back

AltoSsetup

Figure 1.3 AutoSetup menu

I. New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog box
illustrated in Figure 1.4. You continue with defining basic parameters such as blank
thickness, type of process, etc from the dialog box.

New S5imulation

— Simulation

Type: |5heetfnrming ﬂ
— Process

Type: |Single action ﬂ
— Sheet

Thickness: |1 on

— Blank surface

< Bottam < hliddle < Dwal

Cancel

Figure 1.4 New simulation dialog box

1. Select simulation type: Sheet forming.
2.  Select process type: Single Action.
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Single Action

3. Input blank thickness: 1.0 (mm).
4.  Select tools reference: Top. See Figure 1.5a.
5. Click OK to display the main AutoSetup interface.

DIE, PUNCH, BINDER REFER
TO THE SAME MESH (TOP)

ACTUAL PART
WITH THICKNESS

BOTTOM

MIDDLE CONTACT OFFSET=1"t+ 2°Gap

a) Top surface of part

DIE, PUNCH, BINDER REFER
TO THE SAME MESH (MIDDLE)

CONTACT OFFSET=1/2"t+2" Gap

b) Middle surface of part

DIE, PUNCH, BINDER REFER TO
THE SAME MESH (BOTTOM)

l

BOTTOM

MIDDLE CONTACT OFFSET="t+ 2Gap

¢) Bottom surface of part

MESH OF DIE

TOP ACTUAL PART

ITH THICKNESS
G
BOTTOM %’ﬂ

MIDDLE MESH OF PUNCH MESH OF BINER

d) Different surface referred by Die and Punch

Figure 1.5 Tools reference surface
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Il. General
After entering General interface, you do not need to modify any parameters except

for changing the Title into single_action. In addition, you can type in some
comments about the setting/process in the Comment input field illustrated in Figure

1.6.

File Tools Preview Joh

General | Ellanl{| Tools | Frocess | Control |

— Title

Title: |sing|e_actinn

—Warking coordinate system

T o, 0, 0 Global 08
Uads doo o h2RERERS
W-lxiss (0,1, O Laocal C5...
Wi-gxis: (0,0, 1)

— Taoal acceleration time

Acceleration time: (0.001

— Comment

This is a single_action training case.

Submit... Exit

Figure 1.6 General interface

I11. Blank Definition

1. First, use mouse cursor to click on Blank tab to display the blank definition
interface.
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Single Action

Then, click Parts... button from Geometry field in the blank definition
interface. See Figure 1.7.

FEile Tools Preview Jaob

General | Ellank| Tools | Process | Control |

Geometry

Material Thickness Froperty

_—

Mo defined geometry |

Figure 1.7 Define blank

3. The DEFINE GEOMETRY dialog box illustrated in Figure 1.8 is displayed.

Define geometry

— Parts

Femuove Part

Add Elem .. Copy Elem ...

Split part

Display Exit

Figure 1.8 Define Geometry dialog box

4. Click Add Part... button. Use your mouse cursor to select the BLANK part
from the SELECT PART dialog box illustrated in Figure 1.9.
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Select by Cursor

7]
pi|

Select by Name

[ Exclude
Total selected 1
Displayed | All Parts

Reject Last Fart

Ok | Cancel

Figure 1.9 Select Part dialog box

5. After selecting the part, click on OK button to return to DEFINE
GEOMETRY dialog box. The BLANK part is added to the parts list. See
Figure 1.10.

Define geometry

— Parts

BLANK 1

| Remaove Part |

add Elemn ... | CopyEtem .|

Siplit part |

Display | Exit |

Figure 1.10 Blank geometry list
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6. Click the Exit button to return the blank definition interface. Now, the color
of Blank tab is changed to from RED to BLACK. See Figure 1.11.

Eile Tools Preview Joh

— Geometny
FParts... | haterial Thickness Froperty
| oBLANK BLANKMAT  |[1.00 NiP=s |
— Symmetry
Symimetry type: | Mo symimetny Define ...

Figure 1.11 Blank definition interface

IV.Blank Material and Property Definition

Once the BLANK part is defined, the program automatically assigns a default blank
material and relative property. You can also press the BLANKMAT button
illustrated in Figure 1.11 to edit material definition.

After clicking the BLANKMAT button, the MATERIAL dialog box illustrated in
Figure 1.12 is displayed. You can create, edit or import material into the database.
Moreover, you can press the Material Library... button to select generic material
database provided by eta/DYNAFORM. Click on the Material Library... button to
select the United States material library illustrated in Figure 1.12.

Now, you continue to select a material from the material library, as shown in Figure
1.13. After select the material, click Exit to return to the AutoSetup interface.

eta/DYNAFORM Application Manual 9
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84__ BLAMEMAT
Type: T36
Mame: BLAMKMAT 468_|
383
Mewy... T Edit ...
288_
[rmpoart... Export...
Material Library .. © 212
127
T 1 [ [ |
n.on 010 0.20 0.249 0.39 0.449

Dynaform Naterial Library

Figure 1.12 Material dialog box

STEEL

ALUMINUM

Strength Level

Mird

Medium

High

Advanced High

Hot Rolled

Stainless

Material Name

Type 1
ELASTIC

Type 18
POWER

Type 24
LINEAR

Type 36

3-PARAM  ANISOTR FLD_TRA RATE_SEN

Type a7

Type 29

Type 64

ca
DQ
DQsSK
DDQ

+

| + |

¥+

[+ [+

L

|»

BH180
BH210
BH250
BH280

[» ]|

HSLA250
HSLA300
HSLA350
HSLA420

[ T T O TR T

DP500
DPG00

ol

ol e e o e o o o T

ol S G

S e

S e

ca
DQsK
DDQIF
HSLA400

|»

SS11CrCh
SS818CrCh
58304
SS409Ni

[ I»]<f]

AA5182
AASA54
AASTS4
AABOD9

ol e e s e

S o S O o T T O T

e e A G G

ol e e s e

ol e e s e

|» |4

0K

Help

Figure 1.13 United States generic material library
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V. Tools Definition
1. Click on Tools tab to display tool definition interface.

|
2. Click QJ icon from the Icon bar, and turn off the BLANK part.

3. Click OK button to return tool definition interface. Based on the defined
process, three standard tools: die, punch and binder, are listed at the left side
of the tool definition interface. You can continue with definition of each tool.
By default, the die interface is displayed.

4. Press the Parts... button to assign a part as die. See Figure 1.14,

Eile  Tools Preview Johb

General | Blank | Tools | Process | Contral |

Toals: — Current tool
die : | Mame: |die
p._m.;h ..................

hinder [ Sy

Farts Pars. ..

Mo defined geametry !

Figure 1.14 Die definition
5. The DEFINE GEOMETRY dialog box illustrated in Figure 1.15 is
displayed. Next, click the Add Part... button in the dialog box.

Define geometry

— Parts

Rermove Part
Add Elem ... Copy Elem ..
Guide / Pin |

Crisplay Exit

Figure 1.15 Define Geometry dialog box
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6. Select DIE part from the SELECT PART dialog box illustrated in Figure

1.16.

Select by Cursor

/
Select by Mame

BLANK 1
[ Exclude
Tatal selected 1
Displayed All Parts
Feject Last Part
] Cancel

Figure 1.16  Select part dialog box

7. Click OK button to return to the DEFINE GEOMETRY dialog box. DIE
part is added to the list of die. See Figure 1.17.

Define geometry

— Parts

| Rermove Part |

add Elem .. | CopyEtem .|

Guide / Pin |

Display | Exit |

Figure 1.17 Die geometry list
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8. Click Exit button to return to tool definition interface. Now, you can
observe the font color of die is changed to BLACK. See Figure 1.18.

Tools: — CuUrrent tool
die Marme: |die
pumh ...................

hinder [ (S

Parts Parts...

— Working direction

o, dy, dz: | -L J
Move: (0

— Contact

Cffset: |IZI.EI |N|:|ne ﬂ

Friction coef.: |III.1 28 |Btee| ﬂ Advanced ..

Figure 1.18 Die definition interface
9. Select punch located at the left side of tools list to display punch definition
interface.
10. Click Parts... button to display the DEFINE GEOMETRY dialog box
illustrated in Figure 1.19.
11. Then, click Copy Elem... button from the dialog box to display the COPY
ELEMENTS dialog box illustrated in Figure 1.20.
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Define geometry

— Parts

Add Part ... Remaove Part

Add Elern ... | iCopyElem ...

Guide ! Pin

Display Exit |

Figure 1.19 Define Geometry dialog box

12. Press Select... button to select copied element.

Copy elements

;l_ Offset elements

Thickness : 1.1

Elements : 1]

Clear Select ...

Apply Llnda Exit

Figure 1.20 Copy Elements dialog box

13. Select some elements to define punch from the current database. The
program will copy these elements into a default part, and automatically add
the part to the list of punch. Click the DISPLAYED button in the SELECT
ELEMENTS dialog box to select all elements. Toggle on the Exclude
option and select the elements on binder surface using the Spread function
with 2° spread angle, as illustrated in Figure 1.21. The program prompts that
15089 elements have been selected. As illustrated in Figure 1.22, the
elements on binder surface is excluded.
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S5elect Elements

[v Select By Cursor

Angle
[ Select By

Displayed All Elements

[ Filter

[v Exclude

Total Selected 15084

Feject Last Selection

0] Cancel

Figure 1.21  Select elements

Figure 1.22 Highlighted elements

14. Click OK button to return COPY ELEMENTS dialog box. Now, the

eta/DYNAFORM Application Manual 15
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APPLY button is activated. See Figure 1.23.

Copy elements

I_ Offset elements

Thickness : 1.1
Elements : 15084

Clear | Select...l

apply | Unco | Exit |

Figure 1.23 Copy Elements dialog box

15. Click Apply button to copy selected elements to a new part. See Figure
1.24.

Figure 1.24 Copied elements

16. A new part named OFFSETOO is created and added to the list of punch. See
Figure 1.25.
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Define geometry

— Parts

add Elemn ... | CopyEtem .|

Guide / Pin |

Display | Exit |

Figure 1.25 Punch geometry list

17. Click Exit button to return to the tool definition interface. The font color of
punch is also changed to BLACK, as illustrated in Figure 1.26. It means the
punch has been defined.

.....................................

hinder

— Current tool

Mame: |punch

— Geametry
Parts

Parts... |

— Working direction

o, oy, 2 | +5

—

[ [u3=

— Contact

|—2.2*t

|FL|II j
[steel ]

Offset:

Friction coef: |u.125

Advanced ... |

Figure 1.26  Punch definition interface

18. Click binder located at the left side of tool definition interface to display
the binder definition interface. Next, press the Parts... button to display the
DEFINE GEOMETRY dialog box.

eta/DYNAFORM Application Manual
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19.

20.

Click Copy Elem... button, following by pressing the Select... button to
select the elements using the Spread function provided in SELECT
ELEMENTS dialog box.

Click the Spread icon illustrated in Figure 1.27. Then, move the slider bar
to set the spread angle as 3°. Next, use the mouse cursor to pick an element
on the binder surface. The elements on binder surface are highlighted, as
illustrated in Figure 1.28. As illustrated in Figure 1.27, 1590 elements have

been selected.
Select Elements=s

Al & 3| &)
&1 ©

3
1

Angle
[ Select By FPart -

[ arme Lnspecified

Cione

Displayed | AIIEIements|

[ Filter Filter Type

[ Exclude

Total Selected | 1590]|

Reject Last Selection

0]24 | Cancel

Figure 1.27  Select binder elements

18
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Figure 1.28 selected elements

21. Click OK button to exit the SELECT ELEMENTS dialog box. Press Apply
button to copy elements in the COPY ELEMENTS dialog box. All selected
elements are automatically copied to a new part. As illustrated in Figure
1.29, the new created part named OFFSETOL is added to the list of binder.

Define geometry

— Parts

OFFSETO1 5

| Remove Part |

Add Elem _ | Cnpa_.rE|em...|

Guide { Pin |

Display | Ext |

Figure 1.29 Binder geometry list

22. Click Exit button to return the main tool definition interface. The font color
of all tools has been changed red into black. It means that all tools have
been defined.
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VI.  Tools Positioning

After defining all tools, the user needs to position the relative position of tools for
the stamping operation. The tool positioning operation must be carried out each time
the user sets up a stamping simulation model. Otherwise, the user may not obtain
correct stamping simulation setup.

The tool position is related to the working direction of each tool. Therefore, you
need to carefully check the working direction prior to positioning the tools. If the
process template is chosen, the default working direction is selected. You can also
define special working direction.

1. Click the Positioning... button located at the lower right corner of the tool
definition interface to display the POSITIONING dialog box illustrated in
Figure 1.30. Alternatively, you can select Tools->Positioning... from the

menu bar.

— Blank
Translation:
— Tool
Tools Mavement
die 0
punch 0
kinder 0
— Auto-position
Fixed: |punch ﬂ
F Round off Auto
OK ‘ Cancel |

Figure 1.30 Before tools positioning

2. Select the punch as fixed tool and use it as the referenced tool. The tool is
stationary during automatic positioning.

3. Then, click the Auto button to position all tools and blanks. The result is
illustrated in Figure 1.31.

4. Now, all tools and blank(s) are moved to a preset location. The movement
of each tool is listed in the input data field of corresponding tool. The value
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of each tool is listed in the input data field of corresponding tool. The value
Is the measurement from the home/final position to the current position.

Figure 1.31  After tools auto positioning

— Blank
Translation: |-72 .
— Tool
Tools Movement
Vs
die - 262
punch 0
hinder 114
— Auto-pasition
Fixed: |punch ﬂ
 Round o -
QK Cancel

5. Toggle off the checkbox of Lines and Surfaces in Display Options located

at the lower right side of screen. See Figure 1.32.

Current Part : Reset

[ Lines [ Shrink [ Hidden
[ Surfaces [ Marmal [ Fill Calar
[+ Elements [+ Modes [ Shade

Figure 1.32 Display options

6. Click @ and @ icon on the lIcon bar to display the relative

position of tools and blank(s), as shown in Figure 1.33.

7. Click OK button to save the current position of tools and blank(s), and
return to the tool definition interface.
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Figure 1.33 The relative position of tools and blank after positioning

Note: After autopositining, the relative position of tools and blanks is displayed on
the screen. However, you may select Tools-2Positioning... from the Auto
Setup menu bar, following by pressing the Reset button in the POS TIONING
dialog box to set the tools and blank(s) back to its original position.
Moreover, you can move the tools using the Home... function provided in the
Tools menu.

Now, you can continue with the next process which is definition of process
parameters. In Auto Setup application, the definition and positioning of blank(s) and
tools and definition of process are not required in strict order. Therefore, you can
randomly modify each operation. However, you are recommended to accordingly set
up the blank(s) definition, tools definition and process parameters.

VII. Process Definition

The Process definition is utilized to set up process parameters of the current
simulation such as time required for every process, tooling speed, binder force and
so on. The parameters listed in process definition interface depend on the
pre-selected process template, including type of simulation and process.

In this example, the type of simulation and process is Sheet Forming and Single
Action, respectively. Therefore, two default processes are listed in the process
definition interface: closing and drawing process.

You can press Process tab of the main interface to enter process definition interface.
Next, follow the steps listed below:
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1. Select closing process from the list located at left side of the interface as the
current process. See Figure 1.34.

2. Verify the default setting of closing stage is similar to Figure 1.34.

3. Select drawing process from the list located at left side of the interface as the
current process. See Figure 1.35.

4. Verify the default setting of drawing stage is similar to Figure 1.35.

File Tools Preview Joh

Stages: — Current stage

General | Ellanl{| Tools | Frocess | Control |

closing Mame: |c|nsing

drawing ™ Hydro mech

Taoaols

— Tool contral

Action & Walue

[ Show all

die
punch

hinder

|Ve|ucit5r ﬂ |2IIIEIIZI |Trapezuidﬂ

Stationary =

Stationary w

i

— Duration

Type: |Clnsure ﬂ [v Fully match

Tools: |die ﬂ |binder ﬂ Gap: |EI.EI

— D3plot

Frames: |5

Advanced...

Mew stage

Delete stage

Submit...

Exit

Figure 1.34 Closing process interface
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File Tools Preview Joh

Stages: — Current stage
closing Marre: |drawing
drawing ™ Hydro mech
— Tool control
Tools Action & Value [ Show all
die |velocity w|[5000 | Trapezoid v |

punch Stationary =
hinder |F|:|rce ﬂ |EE+IZII]5 |Cnn5tantﬂ ﬂ

— Duration

Type: |Clnsure ﬂ W Fully match
Tools: |die ﬂ|punch ﬂ Gap: |EI.EI

— D3plot

Frames: (10 Advanced...

Mew stage

Delete stage

Submit... Exit

Figure 1.35 Drawing process interface

Note: We suggest the new user not to modify the default parameters in the Control
interface.

VIII.  Animation

Prior to submitting a simulation job, you shall validate the process setting by
viewing the animation of tool movement. The procedure to conduct animation is
listed as the following:
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1. Select Preview->Animation... in the menu bar. See Figure 1.36.

File Tools QBEGHETE Job

Animation. ..

summary...

Figure 1.36  Animation menu
3. The animation of tool movement is shown on the display area.

4. You can select the INDIVIDUAL FRAMES option from the ANIMATE
dialog box illustrated in Figure 1.37 to display the incremental tool
movement.

IF Individual Frames

4| «| »| »i|

24

FramesSecand

Stop

Figure 1.37 Animate dialog box

5. Click ﬂ ﬂ ﬂ ﬂ icon to display the tool movement step by step.

6. The time step and displacement of tools are printed on the upper left hand
corner of the display area. See Figure 1.38.

7. Click Exit button to return the main interface.
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STEP 3 TINE 3.0000000E-002

DIE POSI = 59.000000
PUNCH POSI = 0.08008080
BINDER POSI = ©.0800000

ETA/DYNAFORM

Figure 1.38 Animation of tool movement

IX. SubmitJob

After validating the tools movement, you may continue with submitting the stamping
simulation through the steps listed below:

1. Click Job->Job Submitter... in the menu bar. See Figure 1.39.

Eile Tools Preview

LS-Dyna Input File. .
Full Bun Dyna...

Job Submitter...

Figure 1.39  Job Submitter menu

2. The SUBMIT JOB dialog box illustrated in Figure 1.40 is displayed.
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— Solver

+ Single precision < Double precision

— Dwna input file

File: dMrainingisingle_action.dyn |
— Dption
[ Specify job 10 single_action

[ Specify memaory (MBY. 125

‘[ Subrmit Cancel

Figure 1.40 Submit job dialog box

3. Click Submit button from the SUBMIT JOB dialog box to display the Job
Submitter interface illustrated in Figure 1.41.

Egeta/I.S—D‘HIA Jobs Submitter 3.0 — Personal

LS-Owna ¥ MStep Solver: Control Parameter
@ Single Precigion |Dflsdyna.exe W Auto Memory: 300 MB
£ Double Pracision |D/sdyha. exe Pause betwaen jobs: [1 Sae
£ MStep Solver |D:J’MStep.exe
submit Jobs || Reset Jobs ||
EIEIE & ver|lgl] X [+ [+ [B] 7]
Frecision | File Mame [ In Falder | Size | Type | MB ]| Sec Statuz
Single | x||single_action [d:trainings [17k |dyn 300 [1
]
4] [ 1>
GROUP1

Figure 1.41  Submit job interface

4. Click Submit Jobs button, as shown in Figure 1.41 to activate the LS-DYNA
solver for running the stamping simulation. The LS-DYNA window illustrated in
Figure 1.42 is displayed and the simulation is in progress.
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. LS5DYNA — G:\Training\DF_TEA™1.DYN

total energy ~ initial energy.. 1_APOBBE+BA
energy ratio ws/o eroded energy. 1.A80BEE+BA
globhal x velocity B.ABBRBE+BA
glohal vy velocity 8. A0OBEE+BA
globhal =z velocity B.AARAE+BA

number of zhell elements that

reached the minimum time step..

cpu time per =zone cycle nanoseconds
average cpu time per =zone cycle.... B nanoseconds
average clock time per zone cycle.. 481714 nanoseconds

5
a

B hrs A
B hes A
1 hrs 37
1 hes 37

estimated total cpu time
estimated cpu time to complete
estimated total clock time
estimated clock time to complete

nononon
oo
oo

1]
L]
la N alalal

Wow oW oW

m
[}

added maszs -H8HEE+08
percentage increase .ARBRE+AA

-BRABE+ABR dt 1 .32E-86 flush iso huffers

.BABPE+BA dt 1.32E-06 write d3Iplot file

.758BE-B4 dt 1.32E-0U6 write adaptivity stress file

.758BE-B84 dt 1.32E-B6 increase shells from 1758 to 2113

Figure 1.42 LS-DYNA Solver window

The status of in-progress stamping simulation can be determined by using the sense
switch. The user can press the Ctrl + C key to interrupt the in-progress simulation.
This operation will momentarily pause the solver and prompt the user to input the
sense switch code at “.enter sense switch:” line. There are nine terminal sense
switch codes provided in LS-DYNA. The common sense switch codes are listed
below:

swl — Arestart file is written and solver terminates.
sw2 — Solver responds with estimated time and cycle numbers.
sw3 — Creates a d3dump restart file and solver continues

sw4 — Creates a d3plot file and solver continues.

Note: These switches are case sensitive and must be all lower case when entered.
For information about other sense switch codes, refer to LSDYNA User’s
Manual.

Type in sw2 and press Enter. Notice the estimated time has changed. You can use
these switches anytime while the solver is running.

When you submit a job from etay/DYNAFORM, an input deck is automatically
created. The input deck is adopted by the solver, LS-DYNA, to process the stamping
simulation. The default input deck names are single action.dyn and

28 eta/ DYNAFORM Application Manual



Single Action

single_action.mod. In addition, an index file named single_action.idx is generated
for the reference in eta/POST. The .dyn file contains all of the keyword control cards,
while the .mod file contains the geometry data and boundary conditions. Advanced

users are encouraged to study the .dyn input file. For more information, refer to the
LS-DYNA User’s Manual.

Note: All files generated by either eta/DYNAFORM or LS-DYNA is stored in the
directory in which the eta/DYNAFORM database has been saved. You shall
ensure the folder doesn't include similar files prior to running the current job
because these files will be overwritten.
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII
data files such as glstat, rcforc, etc.. In addition to the undeformed model data, the
d3plot file also contains all result data generated by LS-DYNA (stress, strain, time
history data, deformation, etc.).

I. Reading the Results File into the Post Processor

To execute eta/POST, click PostProcess from eta/DYNAFORM menu bar
illustrated in Figure 1.43. The default path for eta/POST is C:\Program
Files\Dynaform 5.5. In this directory, you can double click on the executable file,
EtaPostProcessor.exe to open eta/POST GUI illustrated in Figure 1.44. The
eta/POST can also be accessed from the programs listing under the start menu of
DYNAFORM 5.5.

File Parts Preprogess | DFE BSE | Setup Tools Option Utiities View 5na|ysis®ﬂelp

\_/
Figure 1.43 PostProcess menu

File Edit Tool Option Help

Sl P el el Tl DA 0 Slelalo] 1 =] <] <[ 0ok

|[[2]

5
ERREE
[Deform Operation
I~ Undefarm

Seale Factor 1.0

2la

Frames

All Frames T | Reset)

From 1 a1 Ine 1

» ] m @
] 4 > H
Frame Mumber
1
FramesiSecond
e —

ETA/POST

¥ Shade ¥ Smooth Shade [ Material Color

#OPEM FILE -
FILE: D3PLOT
LOAD LS-DYMA BINARY FILE CIFIll Colar T Element Edge [ Shrink
PLEASE WAIT, ...

#COMMAMND COMPLETED &

Ready

™ Hidden Surface [ Plate Mormal ™ Background

Figure 1.44 Post process GUI
1. From the File menu of eta/POST, select Open function illustrated in Figure 1.45.
The Open File dialog box illustrated in Figure 1.46 is displayed.
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Irpaort
Export

Copy To Clipboard
Print
it Alt+n

Figure 1.45 File menu

S5elect File

Loak in |D:Rtraininghaiﬂgle_actium v ﬂﬂ

single_action.d3plataa

File Mame: |single_action.d3plot Open |

File Type: |LS-DYNA Fosti daplot, d3drlf, dynain, d3plotaa) + Cancel

Figure 1.46  Open file dialog box

2. The default File Type is LS-DYNA Post (d3plot, d3drlf, dynain). This option
enables you to read in the d3plot, d3drlf or dynain file. The d3plot is output
from forming simulation, such as drawing, binder wrap and springback, while
d3drlf is generated during gravity loading simulation. The dynain is generated
at the end of each simulation. This file contains the deformed blank information.

Note: Please refer to eta/POST User’s Manual for description about other file
types.

3. Choose the directory of the result files. Pick the single_action.d3plot file
illustrated in Figure 1.46, and press Open button.

4. The d3plot file is now completely read in. You are ready to process the results
using the Special icon bar, as shown Figure 1.47.
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<

M« |mz]m
01 7| &|7] = RIRE L

Figure 1.47 Special icon bar for forming analysis
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Il.  Animating Deformation

1. The default Plot State is Deformation. In the Frame dialog, select All Frames
and press Play button to animate the results. See Figure 1.48.

Deform Operation

[ Undeform
Scale Factor |1 A
Frames

All Frames

To|14

Frarm 1

Sinale Frame
Frame Mumber :

: |8 Frames
i Even Frames
Frames/Secand - 0dd Frames

| Select Frames
Range

Figure 1.48 Animating deformation dialog box

2. Toggle on the Shade checkbox in the display options illustrated in Figure 1.49.
The Smooth Shade option is also toggled on by default to enable smooth and
continuous model display.

I ¥ Shade W Smooth Shade [ Material Colar
[T Fill Calor [ Element Edge [ Shrink
[ Hidden Surface [T Plate Marmal [ Background

Figure 1.49 Display options
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3. Since it is difficult to see the Blank with all of the other tools being displayed,

o=
you can hide all the tools by pressing the icon from Icon bar.

4. In Part Operation dialog, use your mouse cursor to click on all the parts,
excluding BLANK, as illustrated in Figure 1.50. All the tools are hidden from the
display area. Then, press Exit button to dismiss the dialog box.

Sort By: In} v

BLANK
PUNCH
BEINDEE

Enter |d: Ii
All Cn | Al Off | Reverse
ndo | Fedo
Exit

Figure 1.50 Turn parts on/off dialog box

5. You can also change the displayed model using the view manipulation icons on
the Icon bar illustrated in Figure 1.51.

RS

1
I
)

3| Q|

Figure 1.51 Icon bar

&

SR

2| N5

g

I11. Animating Deformation, Thickness and FLD

In eta/POST, you can animate deformation, thickness, FLD and various strain/stress
distribution of the blank. Refer to the following examples for animation.

Thickness/Thinning

1. Select L1 icon from the Special icon bar.
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2. Select Current Component from combo box, either THICKNESS or
THINNING. The thickness contour of deformed fender is illustrated in Figure
1.52.

3. Click Play button to animate the thickness contour.
4. Use your mouse cursor to move the slider to set the desired frame speed.

5. Click Stop button to stop the animation.

SINGLE_ACTION
STEP 16 TIME: 0.097930

0.748074 s
COMPONENT: Thickness

0.770346

0.792618

0.814890
0.837162
0.859434
0.881707
0.903979
0.926251
0.948523
0.970795
0.993067
1.015339
1.037611

1.059883

ETA/POST

Figure 1.52 Thickness/Thinning contour

FLD

1. Pick @ from the Special icon bar.

2. Select Middle from the Current Component list. The FLD contour of deformed
fender is illustrated in Figure 1.53.

3. Set FLD parameters (n, t, r, etc.) by clicking on the FLD Curve Option button
to display the FLD CURVE AND OPTION dialog box illustrated in Figure 1.54.

4. Click OK button to dismiss the FLD CURVE AND OPTION dialog box.

5. Select Edit FLD Window function to define location of FLD plot on the display
window.

6. Click Play button to animate the FLD contour of deformed fender.

7. Click Stop button.
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SINGLE_ACTION

STEP 16 TIME:  0.097930
FLD, micddle layer CRACK

1.00 RISK

] OF CRACK
0.80 |

1 SAFE
0.60 |
0.40 | WRINKLE

TENDENCY

0.20

1 WRINKLE
0.00

¥
-
¥ b
ETA/POST

Figure 1.53 FLD contour

FLD Curwe and Option

<l

¥

g < & & o9 0

Figure 1.54 FLD Curve and Option dialog box
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IV. Plotting Single Frames

Sometimes, it is much convenient to analyze the result by viewing single frames
rather than the animation. To view single frame, select Single Frame option from
the Frames combo box illustrated in Figure 1.55. Then, use your mouse cursor to
select the desired frame from the frame list. You can also drag the slider of frame
number to select the frame accordingly.

Deform Operation
[ Undefarm

Scale Factar

Frames
Single Frame j Reset
1--  0.000000 -
2-- 0000783 |
3--  0.001566
4--  0.0023449
5. 0003132 hd
Frarm 1 To 145 [Fir 1
I ] [ o
M 4l 13 H
Frame Mumber
1
[
FramesiSecond
29

Figure 1.55 Display of single frame

V. Writing an AVI and E3D File

eta/POST provides a very useful tool that allows you to automatically create an AVI
movie and/or E3D files via an animation of screen capture. The Record button
illustrated in Figure 1.56 is commonly utilized to generate AVI movie and/or E3D
files. This is the last function covered in this application example.

AVI movie
The following procedure is used to generate an AVI movie file.

1. Start a new animation (thickness, FLD, etc) using the procedure provided in
Section 11I.

2. Display the model in isometric view.
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3. Click the Record button.
4. The Select File dialog box is displayed.

5. Enter a name of the AVI movie file (e.g. traincase.avi) at the input data field of
File Name illustrated in Figure 1.57.

6. Then, click Save button.

7. From the dialog box illustrated in Figure 1.58, select Microsoft Video 1 from the
Compressor list and click Ok button.

8. eta/POST will take a screen capture of the animation and write the output.

Defarm Operatian
[~ Undefarm

Scale Factar |1 0

Frames

JaurFrames ] meset

e

From 1 o 11 Inr 1

» 1] = I o
H 4l [l

Frame Mumber

1

]
Frames/Second
2

Figure 1.56 AVI dialog box
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S5elect File

Loakin |D:Rtrainingkaingle_actium v ﬂﬂ

File Name: [traincase

File Type: |A‘xf|viden|:*.avij| v Cancel |

Figure 1.57 Save AVI file

Select compression format

Compreszor: ok

Cinepak Codec by A adiuz

Cancel

Compreszion Quality: 100

[ 1

Configure. ..

About....

PRl

Figure 1.58 Select compression format

E3D file

You can also save simulation results in a much compact file format (*.e3d). The
*.e3d file can be viewed using eta/3DPlayer which is provided as a free software to
any users.

To create an E3D file, refer to the steps listed below:

1. Start a new animation (thickness, FLD, etc) using the procedure provided in
Section 1I.

2. Display the model in isometric view.

3. Click the Record button.
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4. The Select File dialog box is displayed.
5. Click the drop-down button of File Type to select E3D Player file (*.e3d).

6. Enter a name of the E3D file (e.g. traincase.e3d) at the input data field of File
Name.

7. Then, click Save button.

8. eta/POST will take a screen capture of the animation and write the output into
*.e3d format.

You can view 3D simulation results using the player. To start the player, select
Start->All Programs—>Dynaform 5.5->Eta3DPlayer.
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Example 2.

Double Action
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DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5.

For workstation/Linux users, enter the command “df55” (default) from a UNIX
shell.
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created. You
begin by importing FEA data files to the current database.

Import files

1. From the menu bar, select File=>Import to open the IMPORT file dialog box
illustrated in Figure 2.1. Next, Click the drop-down button of File Type and
select “LSDYNA(*.dyn*.mod;*.k)”. Then, go to the training input files
located in the CD provided along with the eta/DYNAFORM installation.
Locate the data file: double_action.dyn.

2. Use your mouse cursor to select the data file, following by clicking the
Import button. Now, the model illustrated in Figure 2.2 is displayed on the
display area.
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Figure 2.1 Import file dialog box

LR

mp

I

Figure 2.2 Imported model
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Note: Icons may appear different depending on platform. Other functions on the
Icon bar are further discussed in next section. You can also refer to the
eta/DYNAFORM User’s Manual for information about the Icon bar
functions.

3. Save the database to the designated working directory. Select File->Save
as from the menu bar. Next, type in “double_action.df” at the File Name
data input field, as illustrated in Figure 2.3. Then, click Save to save the
database and dismiss the dialog window.

Save in: |Lﬂldn:nul:-le_an:tin:|n j 4= E‘F Eg-

D

by Recent
Diocuments

'T

Desktop

\$

by Documents

by Computer

My M etwark,

Flaces
Filz name: ||:I|:|u|:||e_a|:ti|:|n ﬂ Save |

Save as type: | databaze [*.df] j Cancel

i

Figure 2.3 Save as file

Database Unit

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.
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Edit parts

For ease of identifying each part, modify the name of each part using the Edit Part
dialog box, as illustrated in Figure 2.4. Now, you have four parts, namely BLANK,
PUNCH, BINDER and DIE listed in the part list.

Name  |BLANK

BINDER

P ity Delete

Ok

Figure 2.4 Edit part dialog box
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AUTO SETUP

Prior to entering AUTOSETUP interface, upper/lower tool meshes are required. The
other operation can be carried out in AutoSetup interface, such as PHYSICAL
OFFSET of element, selection of CONTACT OFFSET. As illustrated in Figure 2.5,
you can select AUTOSETUP option from the SETUP menu to display the
AUTOSETUP interface.

File Parts Preprocess | DFE  BSE Tools Option  Utilities  View

Gravity Loading
Diraw Die
Spring Back

AutoSetup

Figure 2.5 Setup menu

I. New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog box, as
illustrated in Figure 2.6. You continue with defining basic parameters such as blank
thickness, type of process, etc from the dialog box.

New Saimulation

— Simulation

Type: |Sheetfnrming ﬂ
— Process

Type: |Dnub|e action ﬂ
— Sheet

Thickness: |1 on

— Blank surface

& Top o Bottorn ¢ Middle # Dual

(0] 54 Cancel

Figure 2.6 New simulation dialog box
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Select simulation type: Sheet forming.
Select process type: Double Action.
Input blank thickness: 1.0 (mm).

Select tools reference: DUAL.

o > L Do

Click OK to display the main AUTOSETUP interface.

Il. General

After entering General interface, you do not need to modify any parameters except
for changing the Title into double_action. In addition, you can type in some
comments about the setting/process in the Comment input field, as illustrated in
Figure 2.7.

In the exercise, you will change the working coordinate into LCS. Make sure the Y
is selected as the Degrees-of-Freedom to define the moving direction.

First, define the working coordinate by clicking the Local CS... button to display
the WCS dialog box, as shown in Figure 2.8. Next, press the W Axis... button to
pop up DIRECTION dialog box, as shown in Figure 2.9. Now, let’s set Y-axis of
global coordinate system as the W-axis of LCS by changing the input data field of X,
Y and Z. As illustrated in Figure 2.9, X=0.0, Y=1.0 and Z=0.0. Click OK button to
exit both WCS and DIRECTION dialog boxes.
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File Tools Preview Joh

Title: |duub|e_actinn
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Origin: 0, 0, 0 lm
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Figure 2.7 General interface
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Direction

¥CS — Direction
— Qiptions w | oo
O |:|:|I|:|I|:|Il e

U ¢1.0.03 ity 1.0
yo(0,1,0) .0

wo(0,0,1) Reverse

- # Origin/ Directions

” — Definition
¢ Defined By 3 Locations
& Vi Direction 2 Points I Modes ...
Existed LCS 3 Points ! Modes Mormal ..
Element Mormal
Qrigin ...

Existed LCS ..

Uﬁxis...| WRAKIS... | YW RS,

Figure 2.8 WCS dialog box Figure 2.9 Direction dialog box

Blank Definition

1. Press the Blank tab to display the blank definition interface.

2. Then, click Parts... button from Geometry field in blank definition interface.
See Figure 2.10.

Geogmetry
' Material Thickness Property
Mo defined geametry !
Figure 2.10 Define blank

3. The program will pop up the DEFINE GEOMETRY dialog box illustrated in
Figure 2.11.

4. Click Add Part... button to display the SELECT PART dialog box illustrated in
Figure 2.12. Let’s use the mouse cursor to select BLANK part from the dialog
box.

5. After selecting the part, you can click OK button to return to the DEFINE
GEOMETRY dialog box. As illustrated in Figure 2.13, the BLANK part has
been added to the list of blank.
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Define geometry

— Parts

{ Add Part ... il Remove Part

Add Elermn ... Copy Elem ...

Siplit part |

Crisplay Exit

Figure 2.11 Define Geometry dialog box

Select by Cursor

Select by Mame

PUNCH 2

BINDER 3

[~ Exclude
Total zelected 1
Displayed | AlPats |

Reject Last Part |

Ok ‘ Cancel |

Figure 2.12 Select Part dialog box

6. Click Exit button to return to the blank definition interface. Now, the color of
Blank tab is changed to from RED to BLACK. See Figure 2.14.
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Define geometry

— Parts

| Remaove Part |

add Elemn ... | CopyEtem .|

Siplit part |

Display | Exit |

Figure 2.13 Blank geometry list

File Tools Preview Job

General | Ellank| Tools | Process | Caontral |

— Geometry
! Pars... | Material Thickness Property
L RO | NIP=5
— Symmetry
Symmetry type: |N0 symmetry Define ...

Figure 2.14  Blank definition interface

IV.Blank Material and Property Definition

Once the BLANK part is defined, the program automatically assigns a default blank
material and relative property. You can also press the BLANKMAT button
illustrated in Figure 2.15 to edit material definition.

Geometry
: material Thickness Froperty

BLAMK. 1 BLAMKMAT | 1.00 MIP=5

Figure 2.15 Blank geometry definition
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After clicking the BLANKMAT button, the MATERIAL dialog box illustrated in
Figure 2.16 is displayed. You can create, edit or import material into the database.
Moreover, you can press the Material Library... button to select generic material
database provided by eta/DYNAFORM. Click on the Material Library... button to
select the United States material library illustrated in Figure2.16.

554 BLAMKMAT
Type: T36
Marmne: BLARKMAT 468
S
Mew... T Edit ... a
298
mpart... Expaort..
Material Librarg ... 212
LInited States _]
Japan 127
China 1 17 1T 1T T T 1T T 1
0.00 010 0.20 0.29 0.39 0.449
_ Europe ||

Figure 2.16 Blank material definition

Now, you continue to select a material from the material library, as shown in Figure
2.17.

Note: You can create your own material or edit the selected material using the
functions provided in MATERIAL dialog box.

Naterial Library

Material Type Strength Level Material Hame ™ ™8 T24 T36 T37 T39 TG4

ca
Mild DQ

DasK

BH1&0
WMedium BHZ210

BH250

HSLAZ50
High HSLA300
HSLA3S0

Lo L Iv e LIr e | |»

STEEL DP500
Advanced High | ppsoo

N N NN N O O O EE E TN T
N N SN S S O O SR SO S
o o SN N N O O SR O SO
o o SN N N O O SR O SO
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Figure 2.17 United States generic material library

V. Symmetry-plane Definition

This example presents a symmetrical dome shape part. Therefore, only quarter of the
part is modeled in order to reduce computational time.

Click Define... button, as shown in Figure 2.18. The SYMMETRY-PLANE dialog
box illustrated in Figure 2.19 is popped up. From the dialog box, you select the
geometry type, Quarter Symmetry. Then, select the boundary nodes illustrated in
Figure 2.20.

Eile Tools Preview Job

| Tools | Frocess | Control |

: Material Thickness Property
— Symmetry
Symmetry type: |Nn symmetry Define ...

Figure 2.18 Blank definition interface
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Syametry—plane

— Geometry type

P

— Symmetry Axis
00,0}
X (1,0)

* LW-Flane
& VW -Plane
¢ 2 points on UV - Plane

Select point(s) .. |

Tolerance : |0.010000

Exit |

Figure 2.19 Symmetry-plane dialog box

[llustration of boundary nodes for symmetry definition

Figure 2.20
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V1. Tools Definition

1. Click on Tools tab to display tool definition interface.

|
2. Click QJ icon from the Icon bar, and turn off the BLANK part.

3. Click OK button to return tool definition interface. Based on the defined
process, three standard tools: die, punch and binder, are listed at the left side
of the tool definition interface. You can continue with definition of each tool.
By default, the die interface is displayed.

4. In punch interface, press Parts... button to assign a part as punch. See
Figure 2.21.

Tools: — Current tool
punch Mame: |punch
die
binder — Geomatry
Farts Farts...
Mo defined geametry |

Figure 2.21  Punch definition

5. The DEFINE GEOMETRY dialog box illustrated in Figure 2.22 is
displayed. Next, click the Add Part... button in the dialog box.

Define geometry

— Parts

| |[remove Part
Add Elem ... | CopyElem ...
Guide /Pin |
Dizplay Exit

Figure 2.22 Define Geometry dialog box

6. Select PUNCH part from the SELECT PART dialog box illustrated in
Figure 2.23.
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Select by Cursor

Select by Marme

[ Exclude
Total selected 1
Displayed | All Parts |

Reject Last Part |

Ok | Cancel |

Figure 2.23  Select part dialog box

7. Click OK button to return to the DEFINE GEOMETRY dialog box.
PUNCH part is added to the list of punch. See Figure 2.24.

Define geometry

— Parts

PUNCH 2

Add Elern . | Copy Elern |

Guide { Pin |

Display | Ext |

Figure 2.24  Punch geometry list

8. Click Exit button to return to tool definition interface. Now, you can
observe the font color of punch is changed to BLACK. See Figure 2.25.
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Tools:

hinder

— Current tool

Mame: |punch

— Geametry

Farts

PLMNCH

Parts...

Figure 2.25 Punch definition interface

9. Select die located at the left side of tools list to display die definition

interface.

10. Click Parts... button to display the DEFINE GEOMETRY dialog box
illustrated in Figure 2.26.

11. Then, click Add Part... button from the dialog box.

Define geometry

— Parts

Add Elern .. | Copy Elemn ...
Guide / Pin |
Display =

Figure 2.26 Define geometry dialog box

12. The program pops up the SELECT PART dialog box illustrated in Figure
2.27. From the list, use your mouse cursor to pick DIE part.
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Select by Cursor

|
s

Select by Mame

[ Exclude

Total selected

1

Displayed | All Parts |
Reject Last Part |
] | Cancel |

Figure 2.27 Select part dialog box

13. Click OK button to dismiss the SELECT PART dialog box. Now, the DIE
part is added to the list of DEFINE GEOMETRY dialog box. See Figure

2.28.

Define geometry

— Parts

add Elem .. | CopyEtem .|

Guide / Pin |

Display |

Exit |
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Figure 2.28 Die geometry list

14. Click Exit button to return to tool definition interface. Now, you can
observe the font color of die is also changed to BLACK. See Figure 2.29.

— Current tool
Mame: |die
— Geametry
Farts Parts. .

Figure 2.29 Die definition interface

15. Click binder located at the left side of tool list to display binder definition

interface.

16. Repeat steps 10-14 to assign the BINDER part as binder.

17. Now, you can observe the font color of binder is also changed to BLACK.
All tools required for the stamping simulation are defined.

Taoaols:
punch
die

hinder

— Current toal

MHame: |hinder

— Gearmetry

FParts

BINDER

FParts...

Figure 2.30 Binder definition interface

VII. Tools Positioning

After defining all tools, the user needs to position the relative position of tools for
the stamping operation. The tool positioning operation must be carried out each time

the user sets up a stamping simulation model. Otherwise, the user may not obtain
correct stamping simulation setup.
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The tool position is related to the working direction of each tool. Therefore, you
need to carefully check the working direction prior to positioning the tools. If the
process template is chosen, the default working direction is selected. You can also
define special working direction.

1. Click the Positioning... button located at the lower right corner of tool
definition interface to display the POSITIONING dialog box illustrated in
Figure 2.31. Alternatively, you can select Tools->Positioning... from the
menu bar.

2. Select die as fixed tool and use it as the referenced tool. The tool is
stationary during automatic positioning.

3. Then, click the Auto button to position all tools and blanks. The result is
illustrated in Figure 2.32.

4. Now, all tools and blank(s) are moved to a preset location. The movement
of each tool is listed in the input data field of corresponding tool. The value
Is the measurement from the home/final position to the current position.

5. Click @ and @ on the Icon bar, and then the relative position of

tools and blanks during die sinking will be displayed on the screen. See
figure 2.33.

6. Click OK to save the current position of tools, and return to the main
interface.

eta/DYNAFORM Application Manual 59



Double Action

— Blank
Translation: [
— Tool
Toals Moverment

punch 0
die 0
hinder I}

— Auta-pasition
Fixed: |die ﬂ
W Found off Auto

Reset| oK | Cancel|

Figure 2.31 Before tools positioning

—_Blank
Translation: |1
— Tool
Toals Moverment

punch -2
die 0
hinder -2

— Auto-position

Fixed: |die

W Round off

Feset | 0]%4 | Cancel|

Figure 2.32  After tools auto positioning
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Figure 2.33  The relative position of tools and blank after positioning

Note: After autopositioning, the relative position of tools and blanksis displayed on
the screen. However, you may select Tools-2Positioning... from the Auto
Setup menu bar, following by pressing the Reset button in the POS TIONING
dialog box to set the tools and blank(s) back to its original position.
Moreover, you can move the tools using the Home... function provided in the
Tools menu.

Now, you can continue with the next process which is definition of process
parameters. In Auto Setup application, the definition and positioning of blank(s) and
tools and definition of process are not required in strict order. Therefore, you can
randomly modify each operation. However, you are recommended to accordingly set
up the blank(s) definition, tools definition and process parameters.

VIIIl. Process Definition

The Process definition is utilized to set up process parameters of the current
simulation such as time required for every process, tooling speed, binder force and
so on. The parameters listed in process definition interface depend on the
pre-selected process template, including type of simulation and process.

In this example, the type of simulation and process is Sheet Forming and Double
Action, respectively. Therefore, two default processes are listed in the process
definition interface: closing and drawing process.
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You can press Process tab of the main interface to enter process definition interface.
Next, follow the steps listed below:

1. Select closing process from the list located at the left side of interface to
be the current process. See Figure 2.34.

2. Verify the default setting of closing stage is similar to Figure 2.34.

3. Select drawing process from the list located at the left side of interface to
be the current process. See Figure 2.35.

4. \erify the default setting of closing stage is similar to Figure 2.35.

Note: In this exercise, DUAL option is selected as Blank Reference Surface.
Therefore, we should toggle off Fully Match option in Duration field to
ensure the tool travel and process time is correctly calculated. When binder
is closed, the default gap between binder and dieis set as 1.1* blank thickness.
We suggest the new user not to modify the default parameters in Control
interface.
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File Tools Preview Joh

Stages: — Current stage

closing Marme: |c|nsing

drawing ™ Hydro mech

— Tool contral
Taoaols Action & Walue [ Show all

dig Stationary =

binder  [velocity w|[2000 | Trapezoid w |

— Dwration

Type: |Clnsure ﬂ [ Fully match
Tools: |binder ﬂ|die ﬂ Gap:|1.17

— D3plot

Frames: |5 Advanced...

Mew stage

Delete stage

Submit... Exit

Figure 2.34 Closing definition interface
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File Tools Preview Joh

General | Ellanl{| Tools | Frocess | Control |

Stages: — Current stage
closing Marre: |drawing
iy [ Hydro mech
— Tool control
Tools Action & Walue [ Show all
punch |"-"E|IIII3i’[‘5" ﬂ |5EIEIIZI |Trapezuidﬂ

die Stationary =
hinder |F|:|rce ﬂ |EE+IZII]5 |Cnn5tantﬂ ﬂ

— Duration

Type: |Trave| ﬂ

Taal: |punch ﬂ Displacement: |35.0
— D3plot

Frames: (10 Advanced...

Mew stage

Delete stage

Submit... Exit

Figure 2.35 Drawing definition interface

IX. Animation

Prior to submitting a simulation job, you shall validate the process setting by
viewing the animation of tool movement. The procedure to conduct animation is
listed as the following:

1. Select Preview->Animation... in the menu bar. See Figure 2.36.
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File Tools BEEUETE Job
Animation...

Summary...

Figure 2.36  Animation menu
2. The animation of tool movement is shown on the display area.

3. You can select INDIVIDUAL FRAMES option from the ANIMATE
dialog box illustrated in Figure 2.37 to display incremental tool
movement.

W Individual Frames

| «a| »| »i|

25

Frames/Second

Stop

Figure 2.37 Animate control dialogue box

4. Click ﬂ ﬂ ﬂ ﬂ icon to display the tool movement step by
step.

5. The time step and displacement of tools are printed on the upper left
hand corner of the display area. See Figure 2.38.

6. Click Exit button to return to the main interface.
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ETA/DYNAFORM

Figure 2.38 Animation of tool movement

X. Submit Job

After validating the tools movement, you may continue with submitting the stamping
simulation through the steps listed below:

1. Select Job>Full Run Dyna... in the menu bar. See Figure 2.39.

LS-Dyta Input Eile...
| Full Bun Dyna...
" Job Submitter...

Figure 2.39  Job menu

2. The program pops up the SUBMIT JOB dialog box illustrated in Figure 2.40.

You can select type of solver (either single or double precision), location of
Dyna input file, specify job ID and memory allocation.

66

eta/ DYNAFORM Application Manual



Double Action

— Salwer

¢ Single precision & Diouble precizion

— Dvna input file

File: d:Mrainingdouble_action.dyn

— Optian
[ Specify job D

[ Specify memaory (MB):

Submit Cancel

Figure 2.40 Submit job dialog box

3. Toggle on the checkbox of Specify job ID option and type in metalforming.

4. Click Submit button from the SUBMIT JOB dialog box to display LS-DYNA

Solver window illustrated in Figure 2.41.

LSDYHA — G:\Training\DF_TRA™1. DYN

total enerqy / initial energy.. 1.A0EBEE+BA
energy ratio wso eroded energy. 1.ABOBBE+BA
glohal x velocity 8. A0OBEE+BA
globhal vy velocity B.ABBRBE+BA
glohal =z velocity 8. AlOBEE+BA

number of shell elements that

reached the minimum time step..

cpu time per zone cycle B nanoseconds
average cpu time per zone cycle.... B nanoseconds
average clock time per =zone cycle.. 4081714 nanoseconds

B hrs B8 minsd
B hrz @ mins?
1 hers 37 minsd
1 hrs 37 nins>

estimated total cpu time
estimated cpu time to complete
estimated total clock time
estimated clock time to complete

MoW oW @
(20 I ]
a g o

N alalal

1]
L]

added maszs = 8 _AAAAE+38
percentage increase = 8. 908RE+08

B.600URE+@A8 dt 1.32E-86 flush iso huffers

A.PABRE+BAA At 1.32E-@6 write d3plot file

2.758BE-84 dt 1.32E-86 write adaptivity stress file

2.7588E-8#4 dt 1.32E-86 increase shells from 1758 to 2113

I
i
289 t
289 t

Figure 2.41 LS-DYNA solver window

eta/DYNAFORM Application Manual

67



Double Action

When you submit a job from etay/DYNAFORM, an input deck is automatically
created. The input deck is adopted by the solver, LS-DYNA, to process the stamping
simulation. The default input deck names are double action.dyn and
double_action.mod. In addition, an index file named double_action.idx is
generated for the reference in eta/POST. The .dyn file contains all of the keyword
control cards, while the .mod file contains the geometry data and boundary
conditions. Advanced users are encouraged to study the .dyn input file. For more
information, refer to the LS-DYNA User’s Manual.

Note: All files generated by either eta/DYNAFORM or LS-DYNA is stored in the
directory in which the eta/DYNAFORM database has been saved. You shall
ensure the folder doesn't include similar files prior to running the current job
because these files will be overwritten.
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII
data files such as glstat, rcforc, etc,. In addition to the undeformed model data, the
d3plot file also contains all result data generated by LS-DYNA (stress, strain, time
history data, deformation, etc.).

Reading the Results File into the Post Processor

To execute eta/POST, click PostProcess from eta/DYNAFORM menu bar
illustrated in Figure 2.42. The default path for eta/POST is C:\Program
Files\Dynaform 5.5. In this directory, you can double click on the executable file,
EtaPostProcessor.exe to open eta/POST GUI illustrated in Figure 2.43. The
eta/POST can also be accessed from the programs listing under the start menu of
DYNAFORM 5.5,

File Parts Preprngess‘QFE 55E|§etup Tools Option  Utiities  wiew gnawsis@ Help

v

Figure 2.42 Post process menu

Eile Edit Tool Option Help

=] o &S Gl AT SleR[e] #] 7= <<= 0] ﬁlﬁ’lﬁl%

|11 12]| I i
K| 3|5

Ceform Cperation
™ Undeform

Scale Factor 1.0

Frames

All Frames © | Reset

» n =] &

H 41 » H
Frame Number
Frames/Second
-_—

Y

.

ETA/POST

FLEASE WAIT, ... =
FCOMMAND COMPLETED

¥ Ghade ¥ Smaooth Shade [ Material Color

#READ INDEX FILE TFill Color [ Element Edge [~ Shrink
PLEASE WiAIT,
#COMMAND COMPLETED

Ready

™ Hidden Surface [~ Plate Mormal ™ Background

Figure 2.43 Post process GUI
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From the File menu of eta/POST, select Open function. The Open File dialog
box illustrated in Figure 2.44 is displayed.

The default File Type is LS-DYNA Post (d3plot, d3drlf, dynain). This option
enables you to read in the d3plot, d3drif or dynain file. The d3plot is output
from forming simulation, such as drawing, binder wrap and springback, while
d3drlf is generated during gravity loading simulation. The dynain is generated
at the end of each simulation. This file contains the deformed blank information.

Note: Please refer to eta/POST User’s Manual for description about other file

types.

Choose the directory of the result files. Pick the metalforming_.d3plot file
illustrated in Figure 2.44, and press Open button.

The d3plot file is now completely read in. You are ready to process the results
using the Special icon bar, as shown Figure 2.45.

Select File

Lookin | D:‘trainingidouble_action v ﬂﬂ
PP :

=& metalforming_.dynain

File Mame: [metalforming_.d3plot Open

File Type: |LS—D\(NA Fosti daplot, d3drlf, dynain, d3plotaa) + Cancel

Figure 2.44 Open file dialog box

M= inijalE
01 7| &|7] = SRR ERE

Figure 2.45 Special icon bar for forming analysis
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Il.  Animating Deformation

1. The default Plot State is Deformation. In the Frame dialog, select All
Frames and press Play button to animate the results. See Figure 2.46.

Deform Operation
[ Undeform

Scale Factar 1.0

Frames

|AII Frames

M = LD B —
1 1 1 1 1
1 1 1 1 1

M 4l 13 H
Frame Mumhber Sngle Frame
: |4/l Frames
0 Even Frames
FramesfSecond - odd Frames

| Select Frames
Fange

Figure 2.46  Animating deformation dialog box

2. Toggle on the Shade checkbox in the display options illustrated in Figure 2.47.
The Smooth Shade option is also toggled on by default to enable smooth and
continuous model display.

¥ Shade W Stmooth Shade T Material Color
[ Fill Color [ Element Edge [ Shrink

[ Hidden Surface [ Plate Mormal [ Backaround

Figure 2.47 Display options
3. Since it is difficult to see the Blank with all of the other tools displayed, you can

“d
hide all of the tools by pressing the icon from Icon bar.

4. In Part Operation dialog, use your mouse cursor to click on all the parts,
excluding BLANK, as illustrated in Figure 2.48. All the tools are hidden form
the display area. Then, press Exit button to dismiss the dialog box.
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Sort By: In} W

PUNCH

BINDER
DIE

Enter [d: Ii
AR | AlOR | Reverse
Undo | Redo
Exit

Figure 2.48 Turn parts on/off dialog box

5. You can also change the displayed model using the view manipulation icons on
the Icon bar illustrated in Figure 2.49.

g

)

N7

SR

(0l 5l ] DIHX]EF| D

Figure 2.49 Icon bar

I11.  Animating Deformation, Thickness and FLD

In eta/POST, you can animate deformation, thickness, FLD and various strain/stress
distribution of the blank. Refer to the following examples for animation.

Thickness/Thinning

1. Select

S

icon from the Special icon bar.

2. Select Current Component from combo box, either THICKNESS or
THINNING. The thickness contour of deformed dome is illustrated in Figure

2.50.

3. Click Play button to animate the thickness contour.

4. Use your mouse cursor to move the slider to set the desired frame speed.

5. Click Stop button to stop the animation.
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DOUBLE_ACTION
STEP 17 TIME: 0.009900

0.683069 .
COMPOHNENT: Thickness

0.706567

0.720166
0.751764
0.774362

0.796960

0.819559
0.842157
0.864755

0.887353
0.909952
0.932550
0.955148

0977746

1.000345
Y
)SL' g
ETA/POST

Figure 2.50 Thickness/Thinning contour

FLD

1. Pick E from the Special icon bar.

2. Select Middle from the Current Component list, as illustrated in Figure 2.51.
The FLD contour of deformed dome is illustrated in Figure 2.52.

3. Set FLD parameters (n, t, r, etc.) by clicking on the FLD Curve Option button
to display the FLD CURVE AND OPTION dialog box.

4. Click OK button to dismiss the FLD CURVE AND OPTION dialog box.

5. Select Edit FLD Window function to define location of FLD plot on the display
window.

6. Click Play button to animate the FLD contour of deformed dome.

7. Click Stop button.
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FLD Qperatian
=Current Laver=
MIDDLE R4

[ Undefarm
W Element Result

FLD Curve Optian

Edit FLD YWindow

ListWalue

FLD Reversed Mapping

Frames
All Frames j Feset

0.000000 Y

0O b —

_._1_

Fram 1 To 145 [FE 1

P m | m | e |
M

Frame Mumber

1
1]
Frames/Second
28
i 1

Figure 2.51 FLD display dialog box

DOUBLE_ACTION

STEP 17 TIME:  0.009998 CRACK I

FLD, middle layer
RISK

OF CRACK

SAFE
WRINKLE
TENDENCY
WRINKLE

SEVERE
WRINKLE
INSUFFICIENT
STRETCH

- I
Y
b
z
ETA/POST

Figure 2.52 FLD contour
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V2 Plotting Single Frames

Sometimes, it is much convenient to analyze the result by viewing single frames
rather than the animation. To view single frame, select Single Frame option from
the Frames combo box illustrated in Figure 2.53. Then, use your mouse cursor to
select the desired frame from the frame list. You can also drag the slider of frame
number to select the frame accordingly.

Deform Operation
[T Undefarm
Scale Factor |1 A
Frames
IEingIe Frame w | Reset
1-- 0.000000 -
2--0.0007833
J-- 0.001566
4--  0.002349
5. 0003132 hd
Frarm 1 To 145 [Fir 1
3 ] [ (9!
H 4l 3 H
Frame Mumber
1
[
FramesiSecond
25
[

Figure 2.53 Display of single frame

Writing an AVI and E3D File

eta/POST provides a very useful tool that allows you to automatically create an AVI
movie and/or E3D files via an animation of screen capture. The Record button
illustrated in Figure 2.54 is commonly utilized to generate AVI movie and/or E3D
files. This is the last function covered in this application example.

AVI movie

The following procedure is used to generate an AVI movie file.

1. Start a new animation using the procedure provided in Section III.
2. Display the model in isometric view.

3. Click the Record button.
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4. The Select File dialog is displayed.
5. Enter a name of the AVI move file (e.g. traincase.avi) at the input data field of
File Name illustrated in Figure 2.55
6. Then, click Save button.
7. From the dialog box illustrated in Figure 2.56, select Microsoft Video 1 from
the Compressor list and click Ok button.
8. eta/POST will take a screen capture of the animation and write the output.
Deform Operation
[ Undefartn
Scale Factar |1 .0
Frames
||AII Frames |vl Rese*
1-- 0.000000 -~
2 0
Frarm 1 11 IfE 1
» 1] = l @ |
H 4l I3 H
Frame Mumber
1
IIJ:I'arT'IESfSEI:Dnd
&
[
Figure 2.54 AVI dialog box
g 7] | @) ek
File Mame: | Save |
File Type: |A\a’| wideor™ awi) :l Cancel |
Figure 2.55 Save AVI file
76 eta/ DYNAFORM Application Manual



Double Action

Select compression format _ |

Compreszor: ok

%)

Cinepak Codec by A adiuz

Cancel

Compreszion Quality: 100

[ 1

Configure. ..

Pl

About....

Figure 2.56 Select compression format
E3D file

You can also save simulation results in a much compact file format (*.e3d). The
*.e3d file can be viewed using eta/3DPlayer which is provided as a free software to
any users.

To create an E3D file, refer to the steps listed below:

1. Start a new animation (thickness, FLD, etc) using the procedure provided in
Section 11I.

Display the model in isometric view.

Click the Record button.

The Select File dialog box is displayed.

Click the drop-down button of File Type to select E3D Player file (*.e3d).

o o » w DN

Enter a name of the E3D file (e.g. traincase.e3d) at the input data field of File
Name.

7. Then, click Save button.

8. eta/POST will take a screen capture of the animation and write the output into
*.e3d format.

You can view 3D simulation results using the player. To start the player, select
Start->All Programs—>Dynaform 5.5->Eta3DPlayer.
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Example 3. Tubular Hydro-forming
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DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5

For workstation/Linux users, enter the command “df55” (default) from a UNIX
shell.

For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created. You
begin by importing FEA data files to the current database.

Import file

From the menu bar, select File=>Import to open the IMPORT FILE dialog box
illustrated in Figure 3.1.

Open @
Loak ir: |l.f,\ has ﬂ = I'j{ Ed-

E

by Recent
Dacuments

-

Desktop

=

\$

ty Documents

ky Computer

My Metwark.  File name: |tu|:-e j

].4
Flaces \—I
Files of type: | MNASTRAM [*.dat” nasg] j [rripart

[ AllFiles Cancel

Figure 3.1 Import file dialog box
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Go to the training input files located in the CD provided along with the
eta/DYNAFORM installation. Then, change the file format to “NASTRAN
(*.dat;*.nas)”. Select tube file, and click OK button to import the file. Now, the
model illustrated in Figure 3.2 is displayed on the display area.

.|‘\k\‘\ ““mmum II’l'l‘

it
\: A

/DYNAFORM

Figure 3.2 Imported model

Save the database
1. Click Save icon from the Icon bar to pop up SAVE AS dialog box illustrated in
Figure 3.3.

2. Next, type in Tubular_hydroforming in the input data field of File Name,
following by clicking Save button to save the database.
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Save As

D

by Recent
Dacuments

;[-':%
Deszktop
by Documentz

by Computer

-

My Metwark,
Flaces

Save i | [ traiming

~| & @k E-

22X

File narne:

Save as type:

|T ubular_Huedroforming

| database [*.di]

[~
=l

Save |
Cancel

Database Unit

Figure 3.3 Save as dialog box

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.
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AUTO SETUP

After saving the database, let’s continue with setting up the model in AUTOSETUP.
Select AUTOSETUP option from the SETUP menu illustrated in Figure 3.4.

File Parts Preprocess | DFE  BSE Tools Option  Utilities  View

Gravity Loading
Diraw Die
Spring Back

AutoSetup

Figure 3.4 Setup menu

I.  New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog
box illustrated in Figure 3.5. You continue with defining basic parameters.

— Simulation

Type: |Tubu|arhydrufurming ﬂ

— Tuhe

Thickness: |EI.B

Cancel

Figure 3.5 New simulation dialog box

1. Select simulation type: Tubular hydroforming.
2. Input tube thickness: 0.8 (mm).
3. Click OK button to display the main AUTOSETUP dialog box.
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I1. General

After entering General interface, you do not need to modify any parameters, except
for changing the Title into Tubular hydroforming. You can select Global
Coordinate System as the working coordinate. For information about other default
parameters, refer to the eta/DYNAFORM User’s Manual.

Tubular hydroforming

Eile  Tools Prewiew Jaokb

General | Tuhe | Tools | Process | Control |

— Title

Title: |T|_|b|_||ar hydro

— Warking coordinate system
Qrigin: (0, 0, 0

Glohal C5
Gmis d.0m o bR
W-pmis: (0,1, O Local 25,
Wi-Ais: (0,0, 1)

— Tool acceleration time

Acceleration time: (0.001

— Comment

Submit... Exit

Figure 3.6  General interface

I1l.  Tube Definition

1. Use your mouse cursor to click on Tube tab to display tube definition interface.
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2. Then click Parts... button from Geometry field in the tube definition interface,
as illustrated in Figure 3.7.

Geometny
Fars... | haterial Thickness Froperty

Mo defined geometry |

Figure 3.7 Define tube

3. The DEFINE GEOMETRY dialog box illustrated in Figure 3.8 is displayed.

Define geometry

— Parts

Femaove Par

Add Elermn ... Copy Elem ...

Siplit part |

Crisplay Exit

Figure 3.8 Define geometry dialog box

4. Click Add Part... button. Use your mouse cursor to select TUBE part from the
SELECT PART dialog box illustrated in Figure 3.9.
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A #l o

Select by Mame

[ Bxclude
Total selected 1
Displayed | All Parts

Feject Last Fart

Ol | Cancel

Figure 3.9 Select part dialog box
5. After selecting the part, click on OK button to return to DEFINE GEOMETRY
dialog box. The TUBE part is added to the list. See Figure3.10.

Define geometry

— Parts

| Remove Part |

add Elemn ... | CopyEtem .|

Siplit part |

Display | Exit |

Figure 3.10 Tube geometry list
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6. Click the Exit button to return the tube definition interface. Now, the color of
Blank tab is changed to from RED to BLACK. See Figure 3.11.

Geometry
: Material Thickness Froperty

B - i e

Figure 3.11 Tube definition

As illustrated in the above figure, the default material and property are assigned to
the tube. Click the BLANKMAT button to open the MATERIAL dialog box
illustrated in Figure 3.12.

554 BLAMKMAT
Type: T3A
Mame: BLARMEMAT 468
CHXE
Mew.. % Edit ... a
298|
Impaort... Export...
Material Library ... % M2
LInited States —
Japan 127
Chins 1 17 17 1T T T T T 1
0.00 010 0.20 0.29 0.39 0.49
_ Europe ||

Figure 3.12 Material dialog box

In this exercise, the hot rolled DQ mild steel from United States material library is
chosen. Click on the Material Library button, following by selecting United
States to display the window shown in Figure 3.13. From the Material Library
window illustrated in Figure 3.13, select DQSK from the Hot Rolled Steel
category.
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Haterial Library

Material Type | Strength Level | Material Hame | T1 T18 T24 T36 T37 T39 T64
D S U U I S i‘
it} DasK S (R U I S
DDGIF S [N T R IR (R |
BH150 S IR T T IS IS il
Medium | BH210 S [N T U S IS
BH250 S [N T IS IS |
HSLAZ50 S IR T I IS IS i‘
High HSLA300 S [N T R IR (R
HSLA350 S [N T U S IS |
— DRS00 S IO S N S
Advanced High | DRS00 P I S B
ca S IO I I S i‘
Hiot Rolled DOSK J # J 4F
CoGIF S I (R T -
S511CrCh S [N [ N S il
Stainless | ss1acrch S I [ (R
55304 S (R U I S |
AA5182 S IR T I S i‘
LML AA545 S (R U I S
AA5T54 S IO I N S -
[N E=Ialxla] -+ | + I -+ | + I -+ | [~
Edit libirary ... | Exit |

Figure 3.13 Material library window

I\VV.  Tools Definition

1. Click on Tools tab to display tool definition interface.

O
2. Click QJ icon from the Icon bar, and turn off the TUBE part.

3. Click OK button to return to tool definition interface. Based on the chosen
template, two standard tools are defined: up_die and lo_die, located at the
left side of tool definition interface. You can continue with definition of
each tool. By default, the up_die interface is displayed, as illustrated in
Figure 3.14.

4. Press the Parts... button to assign a part as up_die.
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Tools: — Current tool
up_die Mame: |up_die
[o_die

— Geometry

Farts Pars. .. ]

Mo defined geometry |

Figure 3.14 Tool definition interface

5. The DEFINE GEOMETRY dialog box illustrated in Figure 3.15 is
displayed. Next, click the Add Part... button in the dialog box.

Define geometry

— Parts

t Add Part .. | Remove Part

Add Elerm ... Capy Elem ...

Guide § Pin |

Display Exit |

Figure 3.15 Define geometry dialog box

6. Select CAM2 part from the SELECT PART dialog box illustrated in Figure
3.16.

7. Click OK button to return to the DEFINE GEOMETRY dialog box. The
CAM2 part is added to the list of up_die. See Figure 3.17.
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Select by Cursor

7]
pi|

Select by Mame

[ Exclude
Taotal selected 1
Displayed | All Parts

Feject Last Part

Ol | Cancel

Figure 3.16  Select part dialog box

Define geometry

— Parts

CAMZ2 &5

add Elemn... | CopyElem .|

Guide / Pin |

Display | Exit |

Figure 3.17 Tube geometry list
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8. Click Exit button to return to tool

definition interface. Now, you can

observe the font color of up_die is changed to BLACK. See Figure 3.18.

FParts... |

Tools: — Current tool
up_die Marne: |up_die
|.;._.;||E ...................
— Geometry
Parts
| CAMZ 5

—'Working direction

o, dy, dz: | -L

fdove: ]

Figure 3.18 up_die definition interface

9. Now, let’s define the working direction of up_die. Click

| button of

working direction field to open the DIRECTION dialog box illustrated in

Direction

Figure 3.19.

— Directian

[0

10

Z|[nn

Feverse

— Definition

2 Points f Modes

3 Points f kodes Mormal ...

Element Marmal

Existed LTS ..

O

Cancel

Figure 3.19 Direction dialog box

10. Click on Y button twice to set the vector of working direction as -1. Then,
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click OK button to dismiss the dialog box.

11. Define contact parameters. Use the default value illustrated in Figure 3.20.

Cantact

Offset: n.o
Friction caef.: [0.1249 Advanced ..

Figure 3.20 Default setting of contact parameters

12. Click lo_die located at the left side of tools list to display lo_die definition
interface.

13. Click Parts... button to display the DEFINE GEOMETRY dialog box.
Follow steps 5-7 to assign DIE part in the SELECT PART dialog box as
lo_die.

14. Click Exit button to return to tool definition interface. Now, you can
observe the font color of lo_die is changed to BLACK. See Figure 3.21.

15. Click = | button of working direction field to open the DIRECTION
dialog box. Then, click on Y button to set the vector of working direction as
+1.

Taols: — Current tool

Mame: |lo_die

— Geometny

Farts Parts...

| DE 2

— Warking direction

dx,dv,dz:| + J
Move: |0

— Contact
COffzet: n.ao

Friction coef: {0125 Advanced ..

Figure 3.21 lo_die definition interface
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16.
17.

18.
19.

20.
21.

22,

Click OK button to dismiss the DIRECTION dialog box.

Click New tool button in the tool definition interface to display the New
Tool interface illustrated in Figure 3.22. At the input data field of Name,
type in dockl. Then, select Use default setting and toggle on Side/Axial
option.

Tools: — Mewy tool
LIFJ_T Mame: [dockl
lo_die
— Default setting
< Llse setting of toal: lo_die -
% Lise default setting [v Side f Axial

Apply

Figure 3.22 Create dockl
Click Apply button to create a new tool named dock1.

Now, you can observe the font color of dockl is red, as illustrated in Figure
3.23. It means the tool geometry and its associated parameters are not
defined.

Tools: — Current tool
up_die Mame: |dockl
lo_die

dncm .................... e

.................................... i Parts Parts

Mo defined geometry |

Figure 3.23 blockl definition interface
Repeat steps 5-7 to assign END1 in SELECT PART dialog box as dockl.

Click Exit button to return to tool definition interface. Now, you can
observe the font color of dockl is changed to BLACK. See Figure 3.24.

Next, let’s modify the default working direction of dockl to +X. Click - |

button to display the DIRECTION dialog box. Click on X button to set the
vector of working direction as +1, as illustrated in Figure 3.25.

92

eta/ DYNAFORM Application Manual



Tubular Hydro-forming

Tools:
Lup_die

lo_die

— Current tool

Mame: [dock1

— Geametry

Parts

Parts...

— Working direction

dedydz |+Z

Mave: 0

Figure 3.24 Define dockl

Direction

— Directian

¥ |oo

Z|[nn

Feverse

— Definition

2 Points f Modes

3 Points f kodes Mormal ...

Element Marmal

Existed LTS ..

0] Cancel

Figure 3.25 Direction dialog box

23. Click OK button to dismiss the DIRECTION dialog box.

24. Now, let’s define the docking rod on the right hand side by repeating steps

17-21. The new tool name is dock2. Select Use setting of tool option

illustrated in Figure 3.26.
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Tools: — Mewy tool

LIF'_T Marme: |dock?

lo_die

dock] — Default setting
# |lse setting of tool: dockl v|
& |se default setting Side § Axial

Figure 3.26 Create dock?2

25. Next, click - | button to display the DIRECTION dialog box.

26. Click on X button twice to set the vector of working direction as -1. See

Figure 3.27.
Tools: — Current tool
up_die Mame: [dock2
lo_die
dockl — Geometry

— Warking direction

o, dy, oz |-}{ J
Mave: ]

Figure 3.27 Define dock?2

27. Click Exit button to return to tool definition interface. The font color of all
tools is changed from red into black, indicating all tools are defined.

V.  Tools Positioning

After defining all tools, the user needs to position the relative position of tools for
the stamping operation. The tool positioning operation must be carried out each time
the user sets up a stamping simulation model. Otherwise, the user may not obtain
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correct stamping simulation setup.

The tool position is related to the working direction of each tool. Therefore, you
need to carefully check the working direction prior to positioning the tools. If the
process template is chosen, the default working direction is selected. You can also
define special working direction.

1. Click Positioning... button located at the lower right corner of tool
definition interface to display the POSITION dialog box illustrated in
Figure 3.28. Alternatively, you can select Tools=>Positioning... from
the menu bar.

Positioning

— Blank

Translation: |0

W

— Tool
Tools Moverment
Up_die ll]i
lo_die [0
dockt [0
dockz o

— Auto-position
Fixed: |I|:|_die ﬂ
¥ Round off Auto |

. Reset | (0] | Cancel

Figure 3.28 Before tools positioning

3. Select lo_die as fixed tool and use it as the reference tool. The tool is stationary
during automatic positioning.

4. Then, click Auto button to position all tools and tube automatically. The result is
illustrated in Figure 3.29.

5. Now all tools and tube are moved to a preset location. The movement of each
tool is listed in the input data field of corresponding tool. The value is the
measurement from the home/final position to the current position.
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— Blank
Translation: IEI
— Tool
Tools mMoverment
up_die |3
lo_die IIZI
dockl |1
dock2 |1

AUto-position

Fixed: Iln_die vl ]

W Round off

Resetl 0] 4 | Cancel

Figure 3.29  After tools auto positioning

6. Click ﬁ and @ icon on the Icon bar to display the relative position of

tools and tube, as shown in Figure 3.30.

Iu]|

= : =
= — =
st L ]
E e - s

= £ —— 2 2 ==
<t ]
= =
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Figure 3.30 The relative position of tools and tube after positioning

7. Click OK button to save the current position of tools and tube, and return to the
tool definition interface.

Note: After autopositioning, the relative position of tools and blanks is displayed on
the screen. However, you may select Tools-2Positioning... from the Auto
Setup menu bar, following by pressing the Reset button in the POS TIONING
dialog box to set the tools and blank(s) back to its original position.
Moreover, you can move the tools using the Home... function provided in the
Tools menu.

Now, you can continue with the next process which is definition of process
parameters. In Auto Setup application, the definition and positioning of blank(s) and
tools and definition of process are not required in strict order. Therefore, you can
randomly modify each operation. However, you are recommended to accordingly set
up the blank(s) definition, tools definition and process parameters.

V1. Process Definition

The Process definition is utilized to set up process parameters of the current
simulation such as time required for every process, tooling speed, binder force and
so on. The parameters listed in process definition interface depend on the
pre-selected process template, including type of simulation and process.

In this example, the type of simulation is Tubular hydroforming. Therefore, the
default processes listed in the process definition interface are closing and
hydroforming.

You can press Process tab of the main interface to enter process definition interface.
Next, follow the steps listed below:

1. Select closing process illustrated in Figure 3.31, following by clicking the
Delete stage button in the process definition interface to remove the process.

2. Now, only the hydroforming process is available in the process definition
interface. Toggle on the Show all option illustrated in Figure 3.32 to display all
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the tools.

3. In hydroforming process, the lo_die remains stationary through out the forming
process. Set the velocity of up_die to -2500 (mm/s) so the tool is moving
downward along the working direction. Both dock1 and dock2 are moving with
the velocity of 500 (mm/s) along their corresponding working direction. See
Figure 3.32.

4. Click on the No Pressure button illustrated in Figure 3.32 to display the
HYDRO MECH dialog box illustrated in Figure 3.33. In pressure control field,
select Constant option. Then, type in constant pressure of 10 (N/mm?).

Tubular hydroforming
Eile Tools Preview Job
General | Tube | Tools | Process | Control |
Stages: — Current stage
closing Mame: ||:Insing
hydroforming Etycro mech
— Tool control
Tools Action & Value ™ Show all
up_die |‘-Ie|n|:it:.f ﬂ |2l:ll:ll:l |Trapemidﬂ
lo_die Stationary w
— Duration
Type: |Clnsure ﬂ [ Fully match
Tools: ||.|p_|:|ie ﬂ||n_die ﬂ Gap: |0.0
— D3plot
Frames: |5 Advanced...
Mew stage
Delete stage
Submit... Exit
Figure 3.31 Closing process interface
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Tubular hydroforming

File Tools Preview Job

General | Tuhe | Tools | Frocess | Control |

Stages: — Current stage

hydroforming Mame: |hydrnfnrmin ad

¥ Hydro mech |Pressure w

— Toal control

Tools Action & Value

W Show all

lo_die Stationary =

up_die |‘ufeln|::it5r ﬂ |-25c|n

|Trapemidﬂ

dock |‘ufe|cu:it5r ﬂ |5|:||:|

|Trapemidﬂ

— Hydro mech

Pressure:

Mo pressure | Mask: Entire |

— Duration
Type: |Time ﬂ

Time: |D.D

— D3plot

Frames: [10

MNew stage

Advanced...

Delete stage

Submit...

Exit

Figure 3.32 Hydroforming process interface

5. Click OK button to dismiss the HYDRO MECH dialog box. As illustrated in
Figure 3.34, the No Pressure button is switched to P=10 indicating the fluid

pressure is defined.
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Hydro mech

— Pressure contral

& Time variable
Fressure: 10.0

Cycle: 200

] | Cancel |

Figure 3.33 Hydro mech dialog box

Hydro mech
|7F'ressure: P =10 Mask: Entire |

Figure 3.34 Hydroforming fluid pressure

6. Next, let’s set the duration field of the process. Type in 0.01 (s) at the input data
field of Time, as illustrated in Figure 3.35.

Ciuration
Type: |Time ﬂ
Time: ||:|.|:|1

Figure 3.35 Hydroforming process time
7. Verify the process setting is defined according to the figures.

8. The default Control setting is adopted.

VIlI.  Animation

Prior to submitting a simulation job, you shall validate the process setting by
viewing the animation of tool movement. The procedure to conduct animation is
listed as the following:

1. Select Preview—>Animation... in the menu bar. See Figure 3.36.
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File Tools B=GHETE Job
Animation...

Summary...

Figure 3.36  Animation menu
2. The animation of tool movement is shown on the display area.

3. You can select the INDIVIDUAL FRAMES option from the ANIMATE
dialog box illustrated in Figure 3.37 to display the incremental tool
movement.

IF Individual Frarmes

4| «| »| >

25

FramesiSecond

Stop

Figure 3.37 Animate control dialog box

4. click ¥ <« > "] jconto display the tool movement step by step.

5. The time step and displacement of tools are printed on the upper left hand
corner of the display area. See Figure 3.38.

6. Click Exit button to return to the main interface.
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STEP 3 TINE = Z2.0900000E-003
UP_DIE POST = -3.000000
LO_DIE PDSI = 8.082000
BLOCK1 POSI = 1.500000
BLOCKZ POST = 1.500000

ETA/DYNAFDRM

Figure 3.38 Movement condition by animation

VIIl. Submit Job

After validating the tools movement, you may continue with submitting the stamping
simulation through the steps listed below:

1. Click Job—=>Job Submitter... in the menu bar. See Figure 3.39.

Eile Tools Preview [l

L3-Dyna Input Eile. ..
Full Bun Dyna...

Job Submitter...

Figure 3.39 Job menu
2. The SUBMIT JOB dialog box illustrated in Figure 3.40 is displayed.

3. Click Submit button from the SUBMIT JOB dialog box to display the Job
Submitter interface illustrated in Figure 3.41.
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— Saolver

# Single precision & Double precizion

— Dyna inputfile

File: dMtrainingtubular_bydrafarming. dyn
— Dptian
v Specify job 1D |Tubu|ar_hydrufnrming

¥ Specify memary (MB): |4nc|

Submit | Cancel

Figure 3.40 Submit job dialog box

EE&tafI.S—DYHA Jobs Submitter 3.0 — Personal

L5-Dwna f MStep Solver: Caontrol Parameter
@ Single Precision |DJLSDYMARrogramilsdyna.exe - | & auto Memary: (200 MEB
£ Double Precision [DJ/LSDYNARrograrm/lsdyna. exe - | Pause between jobs: [1 Sec
£ MStep Solver |D:ILSDYNNprogramIMStep.exe
submit Jobs | ResstJobs ||
Gl ol [ 2 [ +]8]3]
Frecision | File Mame [ In Falder [ size | Twee | MB | Sec | Status 4
Single ¥ TUBULA-~1 [dTRAINI-f |54k [Drem 400 1 |Queued
|
1] | »
GROUMM

Figure 3.41 Submit job interface

5. Click Submit Jobs button to activate the LS-DYNA solver. The LS-DYNA
window illustrated in Figure 3.42 is displayed and the simulation is in progress.
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LSDYRA - d:/TRAIRI™1/TUBULA™1.DTR

eroded internal energy A . ABUUKE +dA
total energy 1.98BUBAE—2@
total energy ~ initial energy.. 1. 9BBPRAE+B@
enerqy ratio wso eroded enerqgy. 1 . AAUUBE +88
glohal x velocity 8. 9RBPAE +B@a
glohal v velocity 8. IRBPRE +B@a
global = velocity A . AUUBE +98

number of shell elements that
reached the minimum time step..
cpu time per zone cycle nanoseconds

average cpu time per zone cycle... nanoseconds
average clock time per =zone cycle. nanoseconds

estimated total cpu time
estimated cpu time to complete
estimated total clock time
estimated clock time to complete

added mass 6. 9255E-A4
percentage increase 7.2861E+81

.BUHRE+HA dt 1.BBE-B6 flush ir/o bhuffers
.AAPBAE+88 dt 1.BBE-B6 write d3plot file

Figure 3.42 LS-DYNA solver window
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII
data files such as glstat, rcforc, etc,. In addition to the undeformed model data, the

d3plot file also contains all result data generated by LS-DYNA (stress, strain, time
history data, deformation, etc.).

I. Reading the Results File into the Post Processor

To execute eta/POST, click PostProcess from eta/DYNAFORM menu bar
illustrated in Figure 3.43. The default path for eta/POST is C:\Program
Files\Dynaform 5.5. In this directory, you can double click on the executable file,
EtaPostProcessor.exe to open eta/POST GUI illustrated in Figure 3.44. The

eta/POST can also be accessed from the programs listing under the start menu of
DYNAFORM 5.5,

File Parts F'repmgess‘QFE 58E|§etup Tools Option  Ulities  View 5na|ysis(PustPrucess)ﬂelp

\_/
Figure 3.43 PostProcess menu
0D - D a g_manua bular hydrofo g ation. d3plo EIE
o] o] el A S QO] A A =] <] € -] 0] o= &
| | ]| [2]) fe] Rt
@iz S

Defarm Operation
™ Undeform

Scale Factor 1o

Frames

All Frames v

From 1 o1 Ine 1

» n m @
H 4l > H

Frame Number

Frames/Second

—————

ETA/POST

#0OPEN FILE 2™ shade ¥ Smooth Shade [ Material Color
FILE: DIPLOT

LOAD LE-DYNA BINARY FILE T Fill Color I Element Edge [T Shrink
PLEASE WAIT,

#FCOMMAND COMPLETED
Ready

I™ Hidden Surface [ Plate Mormal ¥ Backoround

Figure 3.44 Post process GUI
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1. From the File menu of eta/POST, select Open function illustrated in Figure
3.45. The Open File dialog box illustrated in Figure 3.46 is displayed.

Irpaort
Export

Copy To Clipboard
Print
it Alt+n

Figure 3.45 File menu

S5elect File

Lookin | D:training_manuahTubular tydroformingt ==
HE

simulation.d3plotaa

File Type: |LS-DYNA Fosti daplot, d3drlf, dynain, d3plotaa) + Cancel

File Mame: |simulation.d3plot Open |

Figure 3.46 Open file

2. The default File Type is LS-DYNA Post (d3plot, d3drlf, dynain). This
option enables you to read in the d3plot, d3drlf or dynain file. The d3plot
is output from forming simulation, such as drawing, binder wrap and
springback, while d3drlf is generated during gravity loading simulation.
The dynain is generated at the end of each simulation. This file contains the
deformed blank information.

3. Choose the directory of the result files and open the simulation.d3plot file
illustrated in Figure 3.46.

4. The d3plot file is now completely read in. You are ready to process the
results using the Special icon bar, as shown in Figure 3.47.
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N <= | L] [2]| 2]
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Figure 3.47 Special icon bar for forming analysis
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Il.  Animating Deformation

1. The default Plot State is Deformation. In the Frame dialog, select All
Frames and press Play button to animate the results. See Figure 3.48.

Deform Operation

[ Undefarm

Scale Factor |1U—
Frames

All Frames

1.

LT =
1 1
1 1

Frarm 1 To 145 [FiE 1

Sinale Frame
Frame Mumber :

: |8 Frames
i Even Frames
Frames/Secand - 0dd Frames

| Select Frames
Range

Figure 3.48 Animating deformation dialog box

2. Toggle on the Shade checkbox in the display options illustrated in Figure 3.49.
The Smooth Shade option is also toggled on by default to enable smooth and
continuous model display.

V¥ Shade W Smooth Shade [ Material Colar
[ Fill Calar [ Element Edge [ Shrink
[ Hidden Surface [T Plate Marmal [ Background

Figure 3.49 Display options

3. Since it is difficult to see the deformed part with all of the other tools being

el
displayed, you can hide all the tools by pressing the icon from Icon bar.
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4. In Part Operation dialog, use your mouse cursor to click on all the parts,
excluding BLANK, as illustrated in Figure 3.50. All the tools are hidden from
the display area. Then, press Exit button to dismiss the dialog box.

Sort By In] W

Enter Id: Ii
All On | Al Off |Heverse
ndo | Fedo
Exit

Figure 3.50 Part turn on/off dialog box

5. You can also change the displayed model using the view manipulation icons on
the Icon bar illustrated in Figure 3.51.

RS

e
M

| +
.

o] DIl

Figure 3.51 Icon bar
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I11.  Animating Deformation, Thickness and FLD

In eta/POST, you can animate deformation, thickness, FLD and various strain/stress
distribution of the blank. Refer to the following examples for animation.

Thickness/Thinning

1. Select 1 icon from Special icon bar.

2. Select Current Component from combo box, either THICKNESS or
THINNING. The thickness contour of hydroformed tube is illustrated in Figure
3.52.

3. Click Play button to animate the thickness contour.
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4. Use your mouse cursor to move the slider to set the desired frame speed.

5. Click Stop button to stop the animation.

Thickness Operation
=Current Companent=
[THICKNESS |

[ Uindeform
[ Element Result

Contour Setting

Export Contour Line

ListValue

Frames

All Frames j Reset

Frame Mumber
1
il
FramesiSecond

25

Figure 3.52 Thickness/Thinning contour

FLD

1. Pick @ from the Special icon bar.

2. Select Middle from the Current Component list.

3. Set FLD parameters (n, t, r, etc.) by clicking the FLD Curve Option button to
display the FLD CURVE AND OPTION dialog box.

4. Click OK button to dismiss the FLD CURVE AND OPTION dialog box.

5. Select Edit FLD Window function to define location of FLD plot on the display
window.
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6. Click Play button to animate the FLD contour of hydroformed tube, the last
frame of the FLD contour as illustrated in Figure 3.53

7. Click Stop button.

TUBULAR HYDRO

STEP 12 TIME:  0.012001 CRACK
FLD, middie layer
1.00 RISK

| OF CRACK
0.80 |

1 SAFE
0.60 |

4
0.40 _ WRINKLE

] TENDENCY
020 | i

1 ;- NKLE
0.00 Y

05 | 03 .01

ETA/POST

Figure 3.53 FLD contour

IV. Plotting Single Frames

Sometimes, it is much convenient to analyze the result by viewing single frames
rather than the animation. To view single frame, select Single Frame option from
the Frames combo box illustrated in Figure 3.54. Then, use your mouse cursor to
select the desired frame from the frame list. You can also drag the slider of frame
number to select the frame accordingly.
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V.

Defarm Operation
[ Undefarm

Scale Factar

Frames

Single Frame -

0.00000o
0.0007a3
0.001566

e LI R —
1 1 1 1
1 1 1 1

5 --
From 1

0.002345
0.003132

To14

[Fir 1

I
H

m
4l

=
12

4]
H

Frame Mumber
1
[
FramesiSecand

26

Figure 3.54 Display of single frame

Writing an AVI and E3D File

eta/POST provides a very useful tool that allows you to automatically create an AVI
movie and/or E3D files via an animation of screen capture. The Record button
illustrated in Figure 3.55 is commonly utilized to generate AVI movie and/or E3D
files. This is the last function covered in this application example.

AVI movie
The following procedure is used to generate an AVI movie file.

1.

a > w DN

Start a new animation (thickness, FLD, etc) using the procedure provided in
Section 1.

Display the model in isometric view.
Click the Record button.
The Select File dialog box is displayed.

Enter a name of the AVI movie file (e.g. traincase.avi) at the input data field of
File Name illustrated in Figure 3.56.

Then, click Save button.
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7. From the dialog box illustrated in Figure 3.57, select Microsoft Video 1 from
the Compressor list and click Ok button.

8. eta/POST will take a screen capture of the animation and write the output.

Defarm Operatian
[~ Undefarm

Scale Factar |1 0

Frames

JaurFrames ] meset

Fram 1 o 11 IFE 1
» 1] = o
H 4l 2 H

Frame Mumber
1

]
Frames/Second
2

Figure 3.55 AVI dialog box

S5elect File

Lookin  |D:\fraining\tube? v IS E)

File Name- | Save

File Type: |A‘JI video(™ avi) N Cancel

Figure 3.56 Save AVI file
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Select compression format _ |

Compreszor: ok

%)

Cinepak Codec by A adiuz

Cancel

Compreszion Quality: 100

[ 1

Configure. ..

Pl

About....

Figure 3.57 Select compression format
E3D file

You can also save simulation results in a much compact file format (*.e3d). The
*.e3d file can be viewed using eta/3DPlayer which is provided as a free software to
any users.

To create an E3D file, refer to the steps listed below:

1. Start a new animation (thickness, FLD, etc) using the procedure provided in
Section 1.

Display the model in isometric view.

Click the Record button.

The Select File dialog box is displayed.

Click the drop-down button of File Type to select E3D Player file (*.e3d).

o 0 M w DN

Enter a name of the E3D file (e.g. traincase.e3d) at the input data field of File
Name.

7. Then, click Save button.

8. eta/POST will take a screen capture of the animation and write the output into
*.e3d format.

You can view 3D simulation results using the player. To start the player, select
Start->All Programs—>Dynaform 5.5->Eta3DPlayer.
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Example 4. Gravity Loading
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DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5

For workstation/Linux users, enter the command “df55” (default) from a UNIX shell.
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created.

Open the database

From the menu bar, select File->Open... to open the OPEN FILE dialog box
illustrated in Figure 4.1.

Lock in: |15 of = o ol

Double_action_hydro. df
gravity_loading.df

My Recent single_action, df
Documents

B

@

Dezktop

N

\$

by Documents

@

by Computer

My Metwark  File narme: |gravit_l,l_||:|ading.df j Open
Flacez

i

Files of type: | databaze [*.df] j Cancel

Figure 4.1 Open file dialog box
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Go to the training input files located in the CD provided along with the
eta/DYNAFORM installation, and open the data file named gravity _loading.df. The
model shown in Figure 4.2 is displayed on display area.

AT ot e N

i
Pl
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e L
¥
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e e Yo
i ot o e T
it A gy Sy g g
e B T o T

i e T

S
gy L .
R e
T g
et P

Figure 4.2 lllustration of model in Exercise 4

Database Unit

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.
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AUTO SETUP

Prior to entering AUTOSETUP interface, upper/lower tool meshes are required. The
other operation can be carried out in AutoSetup interface, such as PHYSICAL
OFFSET of element, selection of CONTACT OFFSET. As illustrated in Figure 4.3,
you can select AUTOSETUP option from the SETUP menu to display the
AUTOSETUP interface.

File Parts Preprocess | DFE  BsE Tools Option  Utilities  Wiew .

Gravity Loading
Draw Die
Spring Back

AltoSsetup

Figure 4.3 Setup menu

I. New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog box
illustrated in Figure 4.4. You continue with defining basic parameters such as blank
thickness, type of process, etc from the dialog box.

— Simulation

Type: |5heetfnrming ﬂ
— Process

Type: |Gravitg.r ﬂ
— Sheet

Thickness: |1.III

Cancel

Figure 4.4 New simulation dialog box
1. Select simulation type: Sheet forming.

2. Select process type: Gravity.
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3. Input blank thickness: 1.0 (mm).

4. Click OK button to display the main AUTOSETUP interface.

Il. General

After entering General interface, you do not need to modify any parameters except
for changing the Title into single_action. In addition, you can type in some
comments about the setting/process in the Comment input field illustrated in Figure

45,

Eile  Tools Prewiew Jaokb

General | Ellank| Tools | Frocess | Control |

— Title

Title: |gravitg.r_lnading

— Warking coordinate system
Qrigin: (0, 0, 0

Glohal C5
Gmis d.0m o bR
W-pmis: (0,1, O Local 25,
Wi-Ais: (0,0, 1)

— Tool acceleration time

Acceleration time: (0.001

— Comment

Submit... Exit

Figure 4.5 General interface
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I11.Blank Definition

1. Use your mouse cursor to click on Blank tab to display blank definition
interface.

2. Then, click Parts... button from Geometry field in blank definition
interface. See Figure 4.6.

Gegmnetry

----- I5 Ell't5| Material Thickness Froperty

Mo defined geometry !

Figure 4.6 Define blank

3. The DEFINE GEOMETRY dialog box illustrated in Figure 4.7 is displayed.

Define geometry

— Parts

Femuove Part

Add Elem ... Copy Elem ..

Split part |

Crisplay Exit

Figure 4.7 Define geometry dialog box

4. Click Add Part... button. Use your mouse cursor to select BLANK part
from the SELECT PART dialog box illustrated in Figure 4.8.
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Select by Cursor

/
Select by Name

| —cTc—]

[ Exclude
Total selected 1
Displayed | All Parts

Reject Last Fart

Ok | Cancel

Figure 4.8 Select part dialog box

5. After selecting the part, click on OK button to return to DEFINE
GEOMETRY dialog box. The BLANK part is added to the list. See Figure
4.9.

Define geometry

— Parts

| Remove Part |

add Elemn ... | CopyEtem .|

Siplit part |

Display | Exit |

Figure 4.9 Blank geometry list
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6. Click the Exit button to return to the blank definition interface. Now, the
color of Blank tab is changed to from RED to BLACK. See Figure 4.10.

File Tools Preview Job

General | Blank | Tools | Process | control

— Geometry
¢ Pars... | Material Thickness Property
R oowasr oo NIP=5
— Symmetry
Symmetry type: |N0 symmetry Define ...

Submit... Exit

Figure 4.10 Blank definition interface

IV. Blank Material and Property Definition

Once the BLANK part is defined, the program automatically assigns a default blank
material and relative property. You can also press the BLANKMAT button
illustrated in Figure 4.11 to edit material definition.

Geometry

Material Thickness Froperty

_ BLANKMAT | 0.80 NIP=5

Figure 4.11 Blank definition
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After clicking the BLANKMAT button, the MATERIAL dialog box illustrated in
Figure 4.12 is displayed. You can create, edit or import material into the database.
Moreover, you can press the Material Library... button to select generic material
database provided by eta/DYNAFORM. Click on the Material Library... button
to select the United States material library illustrated in Figure 4.12.

554 BLAMKMAT
Type: T36
Marmne: BLARKMAT 468
S
Mew... T Edit ... a
298
mpart... Expaort..
Material Librarg ... 212
LInited States _]
Japan 127
China 1 17 1T 1T T T 1T T 1
0.00 010 0.20 0.29 0.39 0.449
_ Europe ||

Figure 4.12 Define material

Now, you continue to select a material from the material library, as shown in
Figure 4.13.
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Eaterial Library

Material Type  Strength Level  Material Hame T T8 T24 T36 T3IT T39 T64
D + ]+ ]+ - - i‘
Ml DASK T S e T .
DDGIF + ]+ ]+ 4] _+] - -~
BH150 + ]+ ]+ - il
Medium  |BH210 + ]+ ]+ ]+ -
BHz250 + |+ - =+l _+]_+]| - |
HELA250 + ]+ 4]+ _+]_+] - i‘
High HELA300 + |+ ] -
HELA350 | | ] +1 +| +] - <
=L DRS00 | | | ] 1 - -
Advanced High DRSO + | + | + | + | + | - -
e + ]+ |+ _+] - - i‘
HotRoled | posw T R I R T .
DDGIF S I N IR IR B -
SS11CrCh + | _+ | _+1 _+1_+] - - EI
Stainless | =st1gcrch I R R R T ;
5304 | | ] +] +] - -
£85182 T I I I I ) i‘
+ + + + + - -
AL UL AASA5H | | | | |
LAETEY + ]+ ]+ 4] _+] - -
» wenon — e hd
Edit library ... | Exit |

Figure 4.13 United States generic material library

V.  Tools Definition
1. Click on Tools tab to display tool definition interface.

|
2. Click QJ icon from the Icon bar, and turn off the BLANK part.

3. Click OK button to return to tool definition interface. Based on the defined
process, the standard tool listed at the left side of the tool definition
interface is die. You can continue with definition of each tool.

4. Press Parts... button to assign a part as die. See Figure 4.14.
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Taoaols: — Current tool
— Geometry

Parts Parts...

Mo defined geometry |

Figure 4.14 Die definition

5. The DEFINE GEOMETRY dialog box illustrated in Figure 4.15 is
displayed. Next, click Add Part... button in the dialog box.

Define geometry

— Pars

_ il [Remaove Part
Add Elem ... | CopyElem ...
Guide / Pin |
Display Exit

Figure 4.15 Define geometry dialog box

6. Select DIE part from the SELECT PART dialog box illustrated in Figure
4.16.
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Select by Cursor

7]
pi|

Select by Name

[ Exclude
Total selected 1
Displayed | All Parts
Reject Last Fart
] | Cancel

Figure 4.16 Select part

7. Click OK to return tool geometry define dialogue box. DIE part has been
added to the list of die. See Figure 4.17.

Define geometry

— Parts

Add Elern | CDp'g.fElem...|

Guide § Pin |

Display | Ext |

Figure 4.17 Die geometry list

8. Click Exit button to return to tool definition interface. Now, you can
observe the font color of die is changed to BLACK. See Figure 4.18.
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Taoals: — Current tool
dig § Mame: |die
— Geometry

Parts Parts... |

Figure 4.18 Die definition interface

9. Accept the default setting for working direction of tools and contact
parameters.

VI.  Tools Positioning

After defining all tools, the user needs to position the relative position of tools for
the stamping operation. The tool positioning operation must be carried out each time
the user sets up a stamping simulation model. Otherwise, the user may not obtain
correct stamping simulation setup.

The tool position is related to the working direction of each tool. Therefore, you
need to carefully check the working direction prior to positioning the tools. If the
process template is chosen, the default working direction is selected. You can also
define special working direction.

1. Click the Positioning... button located at the lower right corner of tool
definition interface to display the POSITIONING dialog box illustrated in
Figure 4.19. Alternatively, you can select Tools—>Positioning... from the menu
bar.
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— Blank
Translation: |0
— Tool
Tools Movement

die 0
— Auto-position

Fixed: |die ﬂ ||

W Round off Auto

Figure 4.19 Before tools positioning

2. Select die as fixed tool and use it as the reference tool. The tool is stationary
during automatic positioning.

3. Then, click the Auto button to position the tool and blank. The result is
illustrated in Figure 4.20.

4. The movement of each tool is listed in the input data field of corresponding tool.
The value is the measurement from the home/final position to the current

position.

— Blank

Translation: ]334

— Toal
Tools Movement
die 0

— Auto-position

Fixed: |die

¥ Round off

Reset | 0]24 | Cancel|

Figure 4.20 After tools auto positioning
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5. Toggle off the checkbox of Lines and Surfaces in Display Options located at
the lower right side of screen. See Figure 4.21.

Current Part : LOWTOOL Reset

[" Lines [ Shrink [ Hidden
[~ Surface ™ Mormal ™ Fill Color
¥ Elements ¥ Modes [T Shade

Figure 4.21 Display options

6. Click @ and @ icon on the Icon bar to display the relative position of

tool and blank, as shown in Figure 4.22.

Figure 4.22 The relative position of tool and blank after positioning

7. Click OK button to save the current position of tool and blank, and to return to
the main interface.

Note: After autopositioning, the relative position of tools and blanks is displayed on
the screen. However, you may select Tools-2Positioning... from the Auto
Setup menu bar, following by pressing the Reset button in the POS TIONING
dialog box to set the tools and blank(s) back to its original position.
Moreover, you can move the tools using the Home... function provided in the
Tools menu.

Now, you can continue with the next process which is definition of process
parameters. In Auto Setup application, the definition and positioning of blank(s) and
tools and definition of process are not required in strict order. Therefore, you can
randomly modify each operation. However, you are recommended to accordingly set
up the blank(s) definition, tools definition and process parameters.
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VIl. Process Definition

The Process definition is utilized to set up process parameters of the current
simulation such as time required for every process, tooling speed, binder force and
so on. The parameters listed in process definition interface depend on the
pre-selected process template, including type of simulation and process.

In this example, the type of simulation and process is Sheet Forming and Gravity,
respectively. Therefore, only one default process is listed in the process definition
interface: gravity.

You can press Process tab of the main interface to enter process definition interface.
In this exercise, the default setting is adopted.
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File  Tools

Previesy  Job

Stages:

oramity

Mew stage

Delete stage

— Current stage

Mame: |gravitg.r

— Tool control
Tools Action [ Show all

die Stationary W

— Initial velocity

Initial velocity : [0.00

— hilethod

+ Explicit (Dyvnamic relaxation & [mplicit

Jostei e
Submit...

Exit

Animation

Figure 4.23  Gravity process interface

The gravity loading process isn’t part of the forming stage in AUTOSETUP.
Therefore, if you select Preview->Animation..., the dialog box illustrated in Figure
4.24 is displayed. Click OK button to return to main AutoSetup interface.
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Confirmation

Mo farming stage for animation |

Figure 4.24 Confirmation dialog box

IX. Submit Job

After validating the tools movement, you may continue with submitting the stamping
simulation through the steps listed below:

2. Click Job—>Job Submitter... in the menu bar. See Figure 4.25.

File Tools Preview L]

L3-Dyna Input Eile...
Full Bun Dyna...

Job Submitter_ .

Figure 4.25 Job menu

3. The SUBMIT JOB dialog box illustrated in Figure 4.26 is displayed.

— Solver

# Sinagle precision < Double precision

— Dyna input file

File:  |ditraininolgravity.dyn

— Qption

[ Specify job 1D: aravity

[ Specify memory {MB): 128

Submit | Cancel

Figure 4.26 Submit job dialog box

4. Click Submit button from the SUBMIT JOB dialog box to display the Job
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Submitter interface illustrated in Figure 4.27.

Eetafl.s—])‘ﬂu Jobs Submitter 3.0 - Personal

L5-Dna f MStep Sol

Bl

Contral Parameter

@ Single Precision

€ Double Precision

DLEDYMAprogramilsdyna exe

W Auto Mermary: (300 MB

DULSDYMAprogramilsdyna exe

Fausze between jobs: 1 Sec

& MStep Soler |D:ILSDYNNprogramIMStep.exe
SubrmitJabs | Reset Jobs ||
ElEIE & veeltg ot > | 4 [+ [B] 2]
Precision | Fila Mame | In Foldar | size | Twe | mB [ Sec | Status a
Single >]|aravity |d:itrainings |23k |dn 400 [ |Queued
-l
4] | 2]

GROUP1

Figure 4.27 Submit job interface

5. Click Submit Jobs button, as shown in Figure 4.27 to activate the LS-DYNA
solver for running the stamping simulation. The LS-DYNA window illustrated
in Figure 4.28 is displayed and the simulation is in progress.

e LSDYNA — G:\Training\DF_TRA™1.DYN

total energy ~ initial energy..
energy ratio ws/o eroded energy.

glohal
glohal
glohal

numher

x velocity
y velocity
z velocity

of zhell elements t

hat

reached the minimum time step..
cpu time per =zone cycle

average cpu time per =zone cycle.... B nanoseconds
average clock time per zone cycle.. 481714 nanoseconds

estimated total cpu time
estimated cpu time to complete
estimated total clock time
estimated clock time to complete

added maszs
percentage increase

-.BAAAE+AA dt
-.BO0BE+A8 dt
-758BE-84 dt
.758BE-84 dt

-BBBBE+88
. BBRRE+88

.32E-B6
.32E-B6
.32E-B6
.32E-86

1. AABBBE+BA
1 .080B0E+BA
A .AABBBE+PA
8 .98080E+BA
A .AeABBE+BA
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5 s B hrs A
5] B hes A
1 hrs 37
1 hes 37

fluzh iro bhuffers

write d3plot file

write adaptivity stress file

increase shells from 1758 to 2113

Figure 4.28 LS-DYNA solver window

When you submit a job from eta/DYNAFORM, an input deck is automatically
created. The input deck is adopted by the solver, LS-DYNA, to process the stamping
simulation. The default input deck names are gravity.dyn and gravity.mod. In
addition, an index file named gravity.idx is generated for the reference in eta/POST.
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The .dyn file contains all of the keyword control cards, while the .mod file contains
the geometry data and boundary conditions. Advanced users are encouraged to study
the .dyn input file. For more information, refer to the LS-DYNA User’s Manual.

Note: All files generated by either eta/DYNAFORM or LS-DYNA is stored in the
directory in which the eta/DYNAFORM database has been saved. You shall
ensure the folder doesn't include similar files prior to running the current job
because these files will be overwritten.
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII
data files such as glstat, rcforc, etc,. In addition to the undeformed model data, the
d3plot file also contains all result data generated by LS-DYNA (stress, strain, time
history data, deformation, etc.).

Reading the Results File into the Post Processor

To execute eta/POST, click PostProcess from eta/DYNAFORM menu bar
illustrated in Figure 4.29. The default path for eta/POST is C:\Program
Files\Dynaform 5.5. In this directory, you can double click on the executable file,
EtaPostProcessor.exe to open eta/POST GUI illustrated in Figure 4.30. The
eta/POST can also be accessed from the programs listing under the start menu of
DYNAFORM 5.5.

File Parts F'repmgess‘QFE 58E|§etup Tools Option  Utilities  wiew  Analysis( PostProcess) Help

Figure 4.29 PostProcess menu

File Edit Tool Option Help
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ETA/POST

PLEASE WAIT, ...... =
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¥ ghade ¥ gmooth Shade [ Material Colar

#READ INDEX FILE T Fill Color T Element Edge [ Shrink

PLEASE WAIT,

~
I GirIEED I™ Hidden Surface I~ Plate Mormal Kl- Backgraund

Ready

Figure 4.30 Post process GUI
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1. From the File menu of eta/POST, select Open function illustrated in Figure
4.31. The Open File dialog box illustrated in Figure 4.32 is displayed.

[mport
Export

Copy To Cliphoard
Print
it Alt+g

Figure 4.31 File menu

Select File

Lookin | D:trainingigravity_loadingt v ﬂﬂ

o dIddfi1 BE d3drif22 R d3dfas
mm 0301 mE d3drflz RE d3dr23 me d3drifag
mm d3drif02  mE d3drfl3 mE d3drifz4 R d3drifan
BE d3dri3  RE d3difd BE d3drizs R d3driig
mm O304 RE d3drfs mE d3drf26 mw d3drifdz
mm 3005 mE d3drfl6 mE d3drf27 mm d3drifd3
mm d3drM0E  RE d3dif 7 RE d3dri2e R d3driigd
BE d3drf07  mE d3drfie g d3drif29 e d3drifds
mm 3008 mE d3drfle mE d3drf30 mE d3drifd6
mm d3drf09  RE d3dif20 RE d3drfa1 R d3diifa?
= d3dAFI0 mE d3dfz1 R d3drfa7

File Mame: |d3drlf open |

File Type: |LS—D\(NA Fosti daplot, d3drlf, dynain, d3plotaa) + Cancel

Figure 4.32 Open file dialog box

2. The default File Type is LS-DYNA Post (d3plot, d3drlf, dynain). This option
enables you to read in the d3plot, d3drif or dynain file. The d3plot is output
from forming simulation, such as drawing, binder wrap and springback, while
d3drlf is generated during gravity loading simulation. The dynain is generated
at the end of each simulation. This file contains the deformed blank information.

3. Choose the directory of the result files. Pick the d3drlf file illustrated in Figure
4.32, and press Open button.

4. The d3plot file is now completely read in. You are ready to process the results
using the Special icon bar, as shown Figure 4.33.
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<

M« |mz]m
01 7| &|7] = RIRE L

Figure 4.33  Special icon bar for forming analysis

(&

Il.  Animating Deformation

1. The default Plot State is Deformation. In the Frame dialog, select All Frames

and press Play button to animate the results. See Figure 4.34

Deform Operation

[ Undeform
Scale Factor |1 A
Frames

I Il Frames

Frarm 1 To 145 [FiE 1

Frame Mumber Single Frame

1 [l Frames

n) Even Frarnes

Frames/Secand odd Frames

| & Select Frames
Range

Figure 4.34 Animating deformation dialog box

2. Toggle on the Shade checkbox in the display options illustrated in Figure 4.35.

The Smooth Shade option is also toggled on by default to enable smooth and
continuous model display.

¥ Shade W Smooth Shade [ Material Colar
[T Fill Calor [ Element Edge [ Shrink
[ Hidden Surface [T Plate Marmal [ Background

Figure 4.35 Display options
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O
3. From Icon bar, select QJ button to display the PART ON/OFF dialog box
illustrated in Figure 4.36.

4. Use your mouse cursor to select DIE, following by clicking the Exit button to
dismiss the dialog box. Now, only the BLANK part is displayed in the display
area.

Sort By: In} W

-
1 3
Enter [d: Ii
All On | All Off | Feverse
Undo | Redo
Exit

Figure 4.36  Turn parts on/off dialog box

5. You can also change the displayed model using the view manipulation icons on

the Icon bar illustrated in Figure 4.37.
RIS o5

SR

1
I
)

3| Q|

Figure 4.37 lIcon bar

- 5
L. 2

2|

g

I11.  Animating Deformation, Thickness and FLD

In eta/POST, you can animate deformation, thickness, FLD and various strain/stress
distribution of the blank. Refer to the following examples for animation.
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Thickness/Thinning
&z

1. Select =1 icon from the Special icon bar.

2. Select Current Component from combo box, either THICKNESS or
THINNING, as illustrated in Figure 4.38.

3. Click Play button to animate the thickness contour.
4. Use your mouse cursor to move the slider to set the desired frame speed.

5. Click Stop button to stop the animation.

Thickness Operation
=Current Companent=
[THICKNESS ~]

[ Uindeform
[ Element Result

Contour Setting

Export Contour Line

ListValue

Frames

All Frames j Reset

Frame Mumber
1
il
FramesiSecond

25

Figure 4.38 Thickness/Thinning dialog box

IV. Plotting Single Frames

Sometimes, it is much convenient to analyze the result by viewing single frames
rather than the animation. To view single frame, select Single Frame option from
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the Frames combo box illustrated in Figure 4.39. Then, use your mouse cursor to
select the desired frame from the frame list. You can also drag the slider of frame
number to select the frame accordingly.

Defarm Operation
[ Undefarm

Scale Factar

Frames

Single Frame w | Reset

0.00000o -
0.0007a3
0.001566

e LI R —
1 1 1 1
1 1 1 1

5 --
From 1

0.002345
0.003132

To14

[Fir 1

I
H

m
4l

=
12

4]
H

Frame Mumber
1
[
FramesiSecand

26

Figure 4.39 Display of single frame

V.  Writing an AVI and E3D File

eta/POST provides a very useful tool that allows you to automatically create an AVI
movie and/or E3D files via an animation of screen capture. The Record button
illustrated in Figure 4.40 is commonly utilized to generate AVI movie and/or E3D
files. This is the last function covered in this application example.

AVI movie

The following procedure is used to generate an AVI movie file.

1. Start a new animation (thickness, FLD, etc) using the procedure provided in
Section 1.

2. Display the model in isometric view.
3. Click the Record button.

4. The Select File dialog box is displayed.
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5. Enter a name of the AVI movie file (e.g. traincase.avi) at the input data field of
File Name illustrated in Figure 4.41.

6. Then, click Save button.

7. From the dialog box illustrated in Figure 4.42, select Microsoft Video 1 from
the Compressor list and click Ok button.

8. eta/POST will take a screen capture of the animation and write the output.

Defarm Operation

[~ Undefarm
Scale Factar |1 0
Frames

JaurFrames ] meset

From 1 o 11 Inr 1

ST o]

H 4 I H

Frame Mumber
1

I
Frames/Second
2

Figure 4.40 AVI dialog box

S5elect File

Lookin | D:trainingigravity_loading v ﬂ ﬂ
File Mame: |
File Type: |A‘v’| wideo(™ avi v Cancel |

Figure 4.41 Save AVI file
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Select compression format _ |

Compreszor: ok

%)

Cinepak Codec by A adiuz

Cancel

Compreszion Quality: 100

[ 1

Configure. ..

Pl

About....

Figure 4.42 Select compression format

E3D file

You can also save simulation results in a much compact file format (*.e3d). The
*.e3d file can be viewed using eta/3DPlayer which is provided as a free software to
any users.

To create an E3D file, refer to the steps listed below:

1. Start a new animation (thickness, FLD, etc) using the procedure provided in
Section I11.

Display the model in isometric view.

Click the Record button.

The Select File dialog box is displayed.

Click the drop-down button of File Type to select E3D Player file (*.e3d).

o 0 M w DN

Enter a name of the E3D file (e.g. traincase.e3d) at the input data field of File
Name.

7. Then, click Save button.

8. eta/POST will take a screen capture of the animation and write the output into
*.e3d format.

You can view 3D simulation results using the player. To start the player, select
Start-> All Programs—>Dynaform 5.5->Eta3DPlayer.
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Example 5. Single Action - Tailor Welded
Blank

X Y
ETA/DYNAFORM
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DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5

For workstation/Linux users, enter the command “df55” (default) from a UNIX shell.
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created. You
begin by opening an existing database.

Import file

1. From the menu bar, select File=>Import to open the IMPORT FILE dialog
box illustrated in Figure 5.1, Next, Click the drop-down button of File Type
and select “IGES(*.igs;*.iges)”. Then, go to the training input files located in
the CD provided along with the etay/DYNAFORM installation. Locate the
data file: single_action_weld.igs.

2. select the data file, following by clicking the Import button. Now, the model
illustrated in Figure 5.2 is displayed on the display area.
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Loak i |Bigs ﬂ o £F E-
_2 single_action_weld.igs
ku Recent
Daocumnents

Dezktop

ocuments

=
=
=

-

by Computer

m

by M etwark, File narme: |single_au:tiu:un_welu:l ﬂ Ok |
Flaces
Files of type: |IGE5 [*igs." igez) j Impaort
[ Al Files Caricel

Figure 5.1 Open file dialog box

Figure 5.2 Illustration of model in Exercise 5

Note: Icons may appear different depending on platform. Other functions on the
Icon bar are further discussed in next section. You can also refer to the
eta/DYNAFORM User’s Manual for information about the lcon bar

functions.
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Save the database

1. Click Save icon from the Icon bar to pop up SAVE AS dialog box
illustrated in Figure 5.3.

2. Next, type in single_action_weld in the input data field of File Name,
following by clicking Save button to save the database.

Cave i |-._".' single_achion_weld j ¢ 5% ER-

D

by Recent
Clocuments

e

My Metwork  File name: |SiﬂEI|E_-3'3tiDﬂ_WE|E| ﬂ \i]
Flaces
Save az type: | databaze [*.df] _1] ﬂ

Figure 5.3 Save As dialog box

Edit parts

For ease of identifying each part, modify the name of each part using the Edit Part
dialog box, as illustrated in Figure 5.4. Now, you have 2 parts, namely BLANK,
and DIE listed in the part list.
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Database Unit

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.

Marne |EELANH

D 2
Colar |
MHame I}
BELANK 2
T Modify | Delete

Figure 5.4 Edit part dialog box
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MESHING

To curve mesh or surface mesh is an essential step contributing to successful
simulation. There are various methods of creating mesh, however, only Blank
Generator and Surface Mesh will be introduced to generate meshes in this manual.

I. Blank Meshing

Blank meshing is the most important mesh function since the accuracy of the
forming results depends heavily upon the quality of blank mesh. This manual offers
one special function for blank meshing.

1. Select Tools=Blank Generator=BOUNDARY LINE. See Figures 5.5~5.6.

2. Select the BOUNDARY LIN among lines in Selection Option dialog box.

Analysis Setup

Define Tools
Position Tools
Draw Bead

Blank Generator
Guide Pin

Ctri+T
>
Ctri+D

Define Blank
Blank Operation
Material

Broperty

Ctri+B
>

SELECT OPTION

BOUNDARY LINE
SURFACE

Animate
Tools On/off
Summary

TUBE

EXIT DONE | ABORT

Figure 5.5 Blank generator menu Figure 5.6  Select option

3. The SELECT LINE dialog box is shown as Figure 5.7.

S
|7 57
Py
Pt | Reject |
o | cancel |

Figure 5.7 Select line
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4. Shift the method of Select Line into the fourth option and select any line on the
BLANK, and then all curves connected with the selected curves are all chosen.
You can also select curves by using different methods available in SELECT
LINE dialog box. You can place the cursor over each icon and button to identify
its function.

5. After selection, click OK button to open concerned tool radii dialog box. See
Figure 5.8.

6. Use the default variable (6.0) for the concerned tool radii, the shortest radii in
the model. The shorter the radii, the finer the blank mesh; the longer the radii,
the coarser the blank mesh.

W Tool Radius: (5.0

[ Element Size: |15 000000 Dynaform Question

Convert | Accept mesh?
oK ack | cancel | oot
Figure 5.8 Mesh size dialog box Figure 5.9 Question dialog box

7. Click OK button to confirm the radii. Dynaform Question dialog box prompts
“Accept Mesh?”, as shown in Figure 5.9. Click Yes button to accept the
generated mesh.

Note: The user can click ReMesh to correct the concerned tool radii value and
accept the mesh, or click No button to cancel it and repeat the above steps to
re-mesh, if he has entered an incorrect value,

8. Compare the generated mesh with Figure 5.10.

9. Save the database.
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Figure 5.10 Blank meshing

Il. Surface Meshing

Most meshes in eta/DYNAFORM is created by Surface Mesh. This function will
automatically create a mesh based on the provided surface data, which is one quick
and convenient meshing tool.

1. Close BLANK, open DIE and set DIE as current part.
2. Select Preprocess=Elements. See Figure 5.11.
File Parts NiEdpess DFE BSE | =

Line/Foint Ctri+L
Surface Ctrl+=

Element
Mode Ctrl+h

Model CheckiRepair Cirl+R
Boundary Condition  Ctri+l
Mode/Element Set Cirl+

Figure 5.11 Element menu

3. Select Surface Mesh icon from ELEMENT dialog box shown in Figure 5.12.
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Bl | 4| B8B| =
/| | A 1
88| 8| Al|
an | AA| J4| &3
28 | 7|

-

[~ Label Elements
[~ Shrink Elements

oK

Figure 5.12 Element dialog box
In SURFACE MESH dialog box, modify the Max. Size to 10.
Toggle off in Original Part option and the Boundary Check option.
Click Select Surfaces in SURFACE MESH dialog box. See Figure 5.13.
Click Displayed Surf in SURFACE MESH dialog box. See Figure 5.14.

© N o 0 &

Click Apply button in the SURFACE MESH dialog box.

Note: Chordal deviation controls the number of elements along the line/surface curvature;
Angle controls the direction of the feature line;

Gap Tol. Controls whether two adjacent surfaces are connected.
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Surface Nesh

[v Connected

[ LnConnected

[ In Qriginal Part
[ Boundary Check
[~ Refine Sharp Angle

— Parameters

[r-.ﬂax. Size [10.000

Min. Size |0.500

Chaordal Dey. 10,150

RRNAS

Anole |20.000
Gap Tal. (2500
lgnare Haole Size |0.000 Select By Cursor
ey rate & 1| s1| ¢
'WMI ™ Exclude
Roply Pat | Reject |
Accept Mesh? I Displayed Surf
eSS Mo Key in Surf Range |
Exit 0K Cancel |

Figure 5.13  Surface mesh Figure 5.14 Select surface

Note: All displayed surfaces are highlighted in white, indicating that they have
been selected. The dialog window allows you to select the surface(s) in
different ways. Place the cursor over each icon to identify its specified
function.

9. The generated mesh is white. Click Yes when prompted, “Accept Mesh?” in the
SURFACE MESH dialog box. Then, compare the mesh with Figure 5.15.
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Figure 5.15 After part meshing
10. Click Exit button in Surface Mesh to exit, and then save the database.

Now, all parts have been meshed. You may toggle off the checkbox for Surface and
Lines in Display Options to hide the lines and surfaces. It easier to view the mesh.

I11. Mesh Checking

As the mesh has been created, its quality has to be checked to verify that there aren’t
any defects that could cause potential problems in the simulation.

All the tools used for checking the mesh are located in the Preprocess=Model
Check/Repair on the Menu bar, which can be accessed by choosing
Preprocess=Model Check/Repair or Ctr+R. See Figure 5.16.

File Parts Qs DFE BSE |

Line/Paint ST+l
Surface Ctrl+5
Element Ctri+E
rode el -+

Model CheckiFepair Ctri+R
Boundary Condition  Ctrl+LU
Mode/Element Set Crl+

Figure 5.16 Model check/repair
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As shown figure 5.17, the Model Check /Repair dialog box consists of some
functions that enable you to check the quality of mesh. Only three of the functions
are described in this training manual. Please refer to eta/DNAFORM Online Help
for more information about other functions.

Hodel Check & Repair

=
0| O
o

oo
oio

—
*

f

SRy R E

J4| <
B~
&5 T

[~ Label Elements

[~ Shrink Elements

oK

Figure 5.17 Model check/repair dialog box

=
Auto Plate Normal

1. Select Model Check/Repair =Auto Plate Normal from the dialog to open a
new dialog box.

2. The dialog that appears prompts the user two options: SURSOR PICK PART
AND ALL ACTIVE PARTS, which is the default option. Under the default
condition, you may select any element to adjust the normal direction consistency
of all activated parts. Otherwise, you may choose the other option and select one
element of any part that needs checking to adjust this part’s normal direction
consistency. In this example, select any element of DIE as reference element.

3. An arrow that appears on the screen shows the normal direction of the selected
element. A prompt will ask “IS Normal direction acceptable?”. See Figures
5.18~5.109.
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Dynaform Question

Is normal direction acceptable?

Figure 5.18 Question dialog box

X Y
ETA/DYNAFORM

Figure 5.19 Normal direction of the selected element

Pressing the YES button will check all elements in the part and reorient the normal
direction of all elements according to the displayed direction.

Pressing the NO button will check all elements and reverse the normal direction of
all elements according to the displayed direction.

In the example, NO button is pressed. In fact, As long as the normal direction of
most elements in a part is consistent, the program will accept that; if the normal
direction of half of the total element is pointing upward and if that of the other half is
pointing downward, the program will be unable to correctly constrain the blank
through contact. To avoid such problems, you should check the consistency of the
normal direction.

4. After validating the normal direction of elements, save the database.

154 eta/DYNAFORM Application Manual



Single Action - Tailor Welded Blank

Ed
Display Model Boundary J

This function can check the gap, hole or collapsed element on the mesh, and
highlight them, which can help the user to repair these defects.

1. Select Model Check = Display Model Boundary

Minor gaps in the tool mesh (punch, die etc) are acceptable. However, blank mesh
should not contain any gaps or holes unless the blank is lanced or is designed with
gaps. Select the isometric view and then compare it with below Figure 5.20 to detect
the boundary.

Z2

A

X Y
ETA/DYNAFORM

Figure 5.20 Model boundary check

2. Toggle off the checkbox of Elements and Nodes from the Display Options
dialog at right corner of the screen (Note: the boundary lines are still displayed).
This enables you to detect those minor gaps that might be difficult to detect when
the mesh is displayed. If other white lines are also displayed, besides the
boundary, you should repair the defective mesh accordingly . See Figure 5.21.

3. From the following picture, a boundary is seen to be in the middle of the part.
Therefore, you should use the local zoom to position the boundary. Then, select
the repair tools to modify the meshes in the interior boundary.
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) N
A

X Y
ETA/DYNAFORM

Figure 5.21 Boundary line check
4. Use other repair functions to check those overlapping or minimum-size elements.
Delete the duplicated elements if they were found.

5. Turn off all parts except DIE. Click the Clear icon in the Icon bar to remove the
boundary.

6. Save the database.
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AUTO SETUP

Prior to entering AUTOSETUP interface, upper/lower tool meshes are required. The
other operation can be carried out in AutoSetup interface, such as PHYSICAL
OFFSET of element, selection of CONTACT OFFSET. As illustrated in Figure 5.3,
you can select AUTOSETUP option from the SETUP menu to display the
AUTOSETUP interface.

Tools Option  Utilities  Wiew .

File Parts Preprocess | DFE  BsE

Gravity Loading
Draw Die
Spring Back

AltoSsetup

Figure 5.22 Setup menu

I. New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog box, as
illustrated in Figure 5.23. You continue with defining basic parameters such as blank
thickness, type of process, etc from the dialog box.

New Saimulation

— Simulation

Type: |Sheetfnrming ﬂ
— Process

Type: |5ing|e action ﬂ
— Sheet

Thickness: |1 on

— Blank surface

& Top o Bottorn ¢ Middle # Dual

(0] 54 Cancel

Figure 5.23 New simulation dialog box

1. Select simulation type: Sheet Forming.
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Select process type: Single Action.
Input blank thickness: 1.0 (mm).
Select tools reference: Dual.

o~ wn

Il. General

Click OK to display the main AUTOSETUP dialog box.

After entering General interface, you do not need to modify any parameters except
for typing in single_action_weld in input data field of Title. In addition, you can
type in some comments about the setting/process in the Comment input field, as

illustrated in Figure 5.24.

File Tools Preview Joh

General | Ellanl{| Tools | Frocess | Control |

— Title

Title: |sing|e_actiun_weld

—Warking coordinate system
Qrigin: - (0, 0, 0
L-Axis: (1,0, 0%
Welwiss 001, 0
Wi-fxis (0,0, 1)

Global CS

Laocal C5...

— Taoal acceleration time

Acceleration time: (0.001

— Comment

Exit

Figure 5.24  General interface
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I11.Blank Definition

1. Press the Blank tab to display the blank definition interface.

2. Then, click Parts... button from Geometry in blank definition interface.
See Figure 5.25. The program will pop up the DEFINE GEOMETRY
dialog box illustrated in Figure 5.26.

Gegmnetry

----- I5 EII'tS| Material Thickness Froperty

Mo defined geometry !

Figure 5.25 Define blank

Define geometry

— Parts

: Add Part... || Remove Part

Add Elerm ... Copy Elem ...

Split part
P —

Drisplay Exit

Figure 5.26 Define geometry dialog box

3. Click Add Part...to select the blank illustrated in Figure 5.27.

4. Click Split part button to display the SELECT ELEMENTS dialog box
illustrated in Figure 5.29. From the dialog box, press Drag Window icon to
select elements highlighted in Figure 5.30.

5. Click OK button to complete the Split part operation. The selected
elements are copied to a new part named BLKO00000. The part is
automatically included in the blank geometry list illustrated in Figure 5.31.
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Select by Cursor
IR &)=
= '
ﬂ — Pars
- BLANK 2
Select by Mame
1|3
BLANK 2
™ Exclude _Addpart . | Remove Part
Total selected 0 add Elern .. | CopyElem .|
Displayed | Al Parts Split part |
Reject Last Part
Ok | Cancel Digley | =i |
Figure 5.27 Select Part dialog box Figure 5.28 Blank geometry list
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S5elect Elements

A #|[2]8)
&) 1 O

Anile
[T Select By

Displayed All Elements

[ Filter
[ Exclude
Tatal Selected 207

Reject Last Selection |

0]:4 Cancel |

Figure 5.29  Select elements dialog box

ETA/DYNAFOREM

Figure 5.30 Selected elements
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Define geometry

— Parts

BLANK 2

| BLkoooOO 3|

Add Part | Remave F'art|

add Elem .. | CopyEtem .|

Siplit part |

Display | Exit |

Figure 5.31 Blank geometry list

6. Click Exit to return to the Blank definition interface illustrated in Figure
5.32.

Sheet forming

Eile Tools Preview Joh

General | Ellank| Tools | Process | Control |

— Geametry
: Material Thickness Froperty

BNk 2 BLANKMAT  [[1.00 NIP=5
PDEIRGHEEEN sLevonr oo NIP=5

Figure 5.32 Blank definition interface

1VV.Blank Material and Weld Definition

Define geometry

Once the BLANK part is defined, the program automatically assigns a default blank
material and relative property. You can also press the BLANKMAT button
illustrated in Figure 5.32 to edit material definition.

After clicking the BLANKMAT button, the MATERIAL dialog box illustrated in
Figure 5.15 is displayed. You can create, edit or import material into the database.
Moreover, you can press the Material Library... button to select generic material
database provided by eta/DYNAFORM. Click on the Material Library... button to
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select the United States material library illustrated in Figure 5.33.

Type: T36

FHame: BLAREMAT

Mlewy... T

Edit ...

mpart...

Expaort..

Material Likrary ... o

Linited States
'Japan
China
_ Europe

G54

468

383

298

BLAMKMAT

Figure 5.33 Material dialog box

Now, you continue to assign materials to each blank by selecting materials from
the United States generic material library shown in Figure 5.16. In addition, the
blank thickness for BLK0O0000 and BLKO00001 is 1.80 (mm) and 1.00 (mm),
respectively. See Figure 5.34.

Note: You can create your own material or edit the selected material using the
functions provided in MATERIAL dialog box.
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Eaterial Library

Material Type  Strength Level  Material Hame T T8 T24 T36 T3IT T39 T64
D + ]+ ]+ - - i‘
Ml DASK T S e T .
DDGIF + ]+ 4] 4] _+] -~
BH150 NN N N il
Medium  |BH210 + ]+ ]+ ]+ -
BHz250 + |+ - =+l _+]_+]| - |
HELA250 + ]+ 4]+ _+]_+] - i‘
High HELA300 + |+ ] -
HELA350 | | ] +1 +| +] - <
=L DRS00 | | | ] 1 - -
Advanced High DRSO + | + | + | + | + | - -
e | _+ 1 _+ 1 _+1_+1 - - i‘
HotRoled | posw T R I R T .
DDGIF S I N IR IR B -
S511CrCh |+ _+1_+1_+1 - - EI
Stainless =180k + | IF | + | + | + | - -
s5304 + |+ ]+ _+] - -~
£85182 T I I I I ) i‘
+ + + + + _ _
AL UL AASA5H | | | | |
LAETEY + ]+ ]+ 4] _+] - -
» wenon — e hd
Edit library ... | Exit |
Figure 5.34 United States generic material library
— Geormetny
FParts... | hlaterial Thickness Property

| BLARMI: 2 D25k 1.00 HIP=5

Figure 5.35 Blank material and thickness definition

Define weld

1. Click Add... in the Welds field illustrated in Figure 5.36 to display the
BLANK WELD dialog box illustrated in Figure 5.37.
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— Welds

[ Show
Add...
Edit...

Figure 5.36  Define weld

Hlank weld

— Geometny

mHodal piars: 0

Cwerlap blank
Weld width:

Weld ..

— Failure
* Mever Failure

< Conditional Failure

Bormal Force  (100.0
Shear Force 100.0
Exp. for k. Force 1.0
Exp. for 5. Force |1.0
Failure Tirme Te+020

Flastic Strain Te+020

[T Show all welds

Ik Cancel

Figure 5.37 Blank weld dialog box

1. Click Weld... button to display the SELECT NODE dialog box illustrated in
Figure 5.20.

2. Next, using the Drag window option to select the boundary nodes between
two blanks, as illustrated in Figure 5.38.

3. Click OK button to complete the selection. The selected nodes are defined
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as welds illustrated in Figure 5.39.

S5elect Node

Select By Cursor _
Ea Bl paibd

o

[ Exclude

Part Reject

keyvin Mode Ranoge

Q1 Cancel

Figure 5.38 Select node dialog box

Figure 5.39 Selected nodes
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!
1

Figure 5.40 Welds

4. Click OK button in BLANK WELD dialog box to return to AUTOSETUP
interface. You can observe the weld information is listed in the Welds field,
as illustrated in Figure 5.41.

File Tools Preview Job

Generall Ellankl Tnulsl F'rl:u:essl Cnntrnll

— Geometry
Parts... | Material Thickness Froperty
| BLaNK 2 DASK [foo | mIP=s
 BLKDOODD 3 BH180 120 NIP=5
— Symimetny
Svmmetry type: |N|:| symmetry Define ...
— el
Bol 28 node nairs BRewer faillire W Show
Add...
Edit...

Figure 5.41 Welds definition interface
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V. Tools Definition

1. Click on Tools tab to display tool definition interface.

O
2. Click QJ icon from the Icon bar, and turn off the BLANK part.

3. Click OK button to return to tool definition interface. Based on the
defined process, three standard tools: die, punch and binder, are listed at
the left side of the tool definition interface. You can continue with
definition of each tool. By default, the die interface is displayed.

4. Press the Parts... button to assign a part as die. See Figure 5.42.

Tools: — Current tool
e | name: [ue
punm ...................

binder — Geometry

Pars Parts...

Mo defined geometry !

Figure 5.42 Before die definition

5. The DEFINE GEOMETRY dialog box illustrated in Figure 5.43 is
displayed. Next, click the Add Part... button in the dialog box.

Define geometry

— Paris
r\ Remove Part
Add Elem ... | CopyElem ...
Guide /Pin |
Display Exit

Figure 5.43 Define geometry dialog box

6. Select DIE part from the SELECT PART dialog box illustrated in Figure
5.44.
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Select Part

Select by Cursar

7]
pi|

Select by Mame

[ Exclude
Total selected 1
Displayed All Parts

Reject Last Part

0] Cancel

Figure 5.44  Select part dialog box

7. Click OK button to return to the DEFINE GEOMETRY dialog box. DIE
part is added to the list of die. See Figure 5.45.

Define geometry

— Parts

Add Elem ... | Copy Elem |

Guide / Pin |

Display | Bt |

Figure 5.45 Die geometry list
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8. Click Exit button to return to tool definition interface. Now, you can
observe the font color of die is changed to BLACK. See Figure 5.46.

Tools: — Current tool
die Name:|me
punch

hinder [ Sy

Parts Parts... |

Figure 5.46 After die definition

9. Click punch located at the left side of tools list to display punch
definition interface.

10. Click Parts... button to display the DEFINE GEOMETRY dialog box
illustrated in Figure 5.47.

11. Click Copy Elem... button in the dialog box to display the COPY
ELEMENTS dialog box.

12. Toggle on the checkbox of Offset elements option. The default blank
thickness is 1.1*tmax. In this example, tmax is 1.20 (mm)

Define geometry

r— Parts

Remaove Part

Add Elem .. Copy Elem ...

Guide / Pin

Display Exit

Figure 5.47 Define geometry dialog box

13. Next, press Select... button to display the SELECT ELEMENTS dialog
box.

14. Click DISPLAYED to select all elements in the display area. Then,
toggle on the Exclude option, as illustrated in Figure 5.48.
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15. Click the Spread icon, following by moving the slider to set spread
angle as 4°.

16. Pick an element on the binder surface. You observe the highlighted
elements in binder surface are removed. The program prompts that 4464
elements are selected. See Figure 5.48.

Copy elements

IF Offset elements

Thickness : 1.32

Elements : ]

Clear Select ..

Ay LInda Exit

Figure 5.48 Before selecting elements
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S5elect Elements

[v Select By Cursor
0 8
-

Angle
[ Select By Part bt
Marme LInspecified
Done
Displayed | All Elements |
[ Filter Filter Type
v Exclude

Total Selected 4454'

Feject Last Selection

0] Cancel

Figure 5.49 Selected elements

17. Click OK button to return to the COPY ELEMENTS dialog box. Now,

the Apply button is enabled. See Figure 5.50.

Copy elements

[v Offzet elements

Thickness : 1.32

Elements : 1464

Clear

Apply | Llnda Exit

Figure 5.50 After selecting elements

18. Click Apply button to offset the selected elements to a new part. See
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Figure 5.51.

Figure 5.51 Offset elements

19. The new part is added to the list of punch. See Figure 5.52.

Define geometry

— Parts

Add Elem ... | CopyElem .|

Guide § Pin |

Display Bt |

Figure 5.52 Punch geometry list

20. Click Exit button to return to tool definition interface. The font color of
punch is also changed to BLACK, as illustrated in Figure 5.53. Since the
DUAL option was selected in NEW SIMULATION dialog box, the
None option is automatically selected in the Contact Offset field
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illustrated in Figure 5.53. It means numerical contact offset is not applied

to punch.

Tools: — Current tool
die Mame: |pun|:h
punch
hindar [ LErel
FParts
— Working direction
oz oy, oz |+E
e ]
— Contact
Offzet: 'LI.LI iNnne -
Friction coef.: |IZI.125 iSteeI ﬂ Advanced ...
Figure 5.53 Punch definition
21. Click binder near the left side of tools interface to display binder

definition interface.
22.
23.

Press Parts... button to display the DEFINE GEOMETRY dialog box.
Click Copy Elem... button, following by pressing Select... button in

COPY ELEMENTS dialog box illustrated in Figure 5.54.

24.

From the SELECT ELEMENTS dialog box, click Spread icon illustrated

in Figure 5.54. Then, use your mouse cursor to move the slider to set

spread angle as 4°.

25.

Pick an element on the binder region to highlight all elements of binder

surface, as illustrated in Figure 5.55. The program prompts 2014

elements have been selected.
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S5elect Elements

[v Select By Cursor
0 8
-

Angle
[ Select By Fart -
Marme LInspecified
Copy elements
Dione
v Offzet elements
Displayed All Elements
Thickness : 1.32
[ Filter Filter Type
Elernents . 0 [ Exclude
Claar Total Selected 2014
Feject Last Selection
Ay LInda Exit Ok Fe—

Figure 5.54  Select binder element
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Figure 5.55 Selected elements

26. Click OK button to exit the SELECT ELEMENTS dialog box. Next,

click Apply button to automatically offset all selected elements to a new

part. The part is added to the list of binder. See Figure 5.56.

Define geometry

— Parts

727 Remore par

OFFSETO1 5

Add Elem . | Copy Elem ..

Guide I Pin

Ezxit

Display

Figure 5.56 Binder geometry list
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28.

29.

30.

31.

32.

Contact
Offset: |III.IZI |N|:|ne ﬂ
Friction coef.: [0.125 |steel |

Figure 5.57 Contact setting

|
Click JJJ icon from Icon bar. Click All off button to hide all parts.

Next, use your mouse cursor to pick DIE. Then, click OK button to
dismiss the PART TURN ON/OFF dialog box. Only DIE is displayed in
the display area.

The working directions of the defined tools are along the Z direction of
Global Coordinate System. However, the feature encircled in Figure 5.40
cannot be formed along the working direction due to backdraft angle.
Therefore, a separate process with different working direction is needed
to facilitate cam forming operation in making of the feature.

Figure 5.58 Cam formed feature

From tool definition interface, click New tool button to create a new tool
named pun2. Select the default setting shown in Figure 5.59. Then, press
Apply button.

Click Parts... to display the DEFINE GEOMETRY dialog box
illustrated in Figure 5.42. Then, press Copy Elem... button to display
the COPY ELEMENTS dialog box illustrated in Figure 5.61.
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Define geometry

— Mlew tool

Hame: [punz

— Default setting

+ llse setting of tool;

< Lse default setting

punch ﬂ

Side I Axial

Apply |

Figure 5.59 Create new tool

— Parts

Femuove Part

Add Elermn | Copy Elem .. [||

Guide I Pin

Display Exit

Figure 5.60 Define geometry dialog box

33.

34.

35.

36.

Copy elements

v Offzet elements

Thickness : 1.32

Elements : ]

Clear

Apply Linda Exit

Figure 5.61 Copy elements dialog box

Click Select button to display the SELECT ELEMENTS dialog box

illustrated in Figure 5.62.

Select the highlighted elements in Figure 5.62 using the Multi-Point

Region function.

Click OK button to accept element selections and return to the COPY
ELEMENTS dialog box. Now, Apply button is enabled, as illustrated in

Figure 5.63.

Click Apply button to copy the selected elements to a new part.
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37. Click Exit button to dismiss the COPY ELEMENTS dialog box.

Select Elements
v Select By Cursor

Angle
[~ Select By

Displayed All Elements |

[ Filter
[~ Exclude
Total Selected ]

Reject Last Selection

Ok | Cancel

Figure 5.62 Select elements

Copy elements

[w Offset elements

Thickness : -1.32

Clear | Select ... |

Ay Exit

Figure 5.63 Copy elements dialog box

38. Click Exit button to return to tool definition interface. Now, let’s
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continue to define the working direction of pun2.

39. Press | button to display the DIRECTION dialog box illustrated in

Figure 5.64.

YWorking direction

d}{,dﬁ;,dz:| +7

frlove: |III

Figure 5.64 Working direction definition

40. Click Element Normal button. Then, use your mouse cursor to pick an
element on the flat region of pun2, as illustrated in Figure 5.65. An
arrow indicating the working director is displayed.

41. Click OK button to dismiss the DIRECTION dialog box. The vector of
working direction for pun2 is listed in the Working Direction field.

42. Click Exit button in the AUTOSETUP interface.

43. Click | L_u icon from the Icon bar to save the database.

Direction

— Directian

| [o.2189
o |[oo
Z|[ogrez

Feverse

— Definition

2 Points f Hodes .

3 Points i Modes Mormal ...

Element Mormal ||

] Cancel

Figure 5.65 Display element normal
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44. Next, repeat steps 28-29.

45. From the menu bar, select Preprocess->Element. Press E icon,

following by using the Multi-Point Region function to select the
highlighted elements in Figure 5.66

Figure 5.66 Delete elements

46. Click OK button to accept element selection and remove the selected
elements from the database.

=
47. Then, click =21 icon from the Icon bar to remove the free nodes.

48. Now, all tools have been defined. You may return to Tools tabs of
AUTOSETUP interface to continue next operation.

VI.  Tools Positioning

After all tools are defined, you need to position the relative position of tools for the
stamping operation. The tool positioning operation must be carried out each time the
user sets up a stamping simulation model. Otherwise, you may not obtain correct
stamping simulation setup.

The tool position is related to the working direction of each tool. Therefore, you
need to carefully check the working direction prior to positioning the tools. If the
process template is chosen, the default working direction is selected. You can also
define special working direction.

1. Click the Positioning... button located at the lower right corner of tool
definition interface to display the POSITIONING dialog box illustrated in
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Figure 5.67. Alternatively, you can select Tools=>Positioning... from the
menu bar.

Select punch as fixed tool and use it as the reference tool. The tool is
stationary during automatic positioning.

Then, clicks Auto button to position all tools and blank. The result is
illustrated in Figure 5.68.

Now, all tools and blank are moved to a preset location. The movement of
each tool is listed in the input data field of corresponding tool. The value is

the measurement from the home/final position to the current position.

Toggle off the checkbox of Lines and Surfaces in Display Options located
at the lower right side of screen. See Figure 5.69.

— Blank — Blank
Translation: |0 Translation: |52
— Tool — Tool
Tools mMoverment Tools mMoverment
die ] die -54
punch 1] punch 1]
hinder 0 hinder H
punz 0 punz -40
— Auto-position —— — Auto-position
Fixed: |pun|:h ﬂ Fixed: |pun|:h ﬂ
W Round off At W Round off
Reset| 0] | cancel Feset | 0] | cancel

Figure 5.67 Before tool positioning Figure 5.68 After tool auto positioning
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Current Part : LOWTOOL Reset

" Lines ™ Shrink ™ Hidden
[™ Surface ™ Mormal ™ Fill Colar
v Elements v Modes [" Shade

Figure 5.69 Display options

6. Click @ and @ icon on the Icon bar to display the relative
position of tools and blank, as illustrated in Figure 5.70.

7. Click OK button to save the current position of tools and blank, and return
to the tool definition interface.

Figure 5.70 The relative position of tools and blank after positioning

Note: After autopositioning, the relative position of tools and blanks is displayed on
the screen. However, you may select Tools-2Positioning... from the Auto
Setup menu bar, following by pressing the Reset button in the POS TIONING
dialog box to set the tools and blank(s) back to its original position.
Moreover, you can move the tools using the Home... function provided in the
Tools menu.

Now, you can continue with the next process which is definition of process
parameters. In Auto Setup application, the definition and positioning of blank(s) and
tools and definition of process are not required in strict order. Therefore, you can
randomly modify each operation. However, you are recommended to accordingly set
up the blank(s) definition, tools definition and process parameters.
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VII.  Process Definition

The Process definition is utilized to set up process parameters of the current
simulation such as time required for every process, tooling speed, binder force and
so on. The parameters listed in process definition interface depend on the
pre-selected process template, including type of simulation and process.

In this example, the type of simulation and process is Sheet Forming and Single
Action, respectively. Therefore, two default processes are listed in the process
definition interface: closing and drawing process.

You can press Process tab of the main interface to enter process definition interface.
Next, follow the steps listed below:

1. Select closing process from the list located at left side of the interface as the
current process. See Figure 5.71.

2. Verify the default setting of closing stage is similar to Figure 5.71.

3. Select drawing process from the list located at left side of the interface as
the current process. See Figure 5.72.

4. \ferify the default setting of drawing stage is similar to Figure 5.72.
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File  Tools

Previesy  Job

Stages:

closing

dramving

MHew stage

Delete stage

General | Ellanl-:| Tools | Frocess | Control |

— Current stage

MHarme: ||:I|:|5ing

[ Hydro mech

— Tool control
Tools Action & Value " Show all
die |velocity {2000 | Trapezoid v |
punch W
hinder W

— Duration

Type: |Clnaure

ﬂ [ Fully match

Tools: |die

j |binder

ﬂ Gap: |III.EI

— D3plot

Frames: |5

Advanced...

Submit...

Exit

Figure 5.71 Closing process interface

eta/DYNAFORM Application Manual

185



Single Action - Tailor Welded Blank

File Tools

Previews  Joh

Stages:

closing

.....................................

ews stage

Delete stage

General | Ellank| Tools | Process | Control |

— Current stage

MHarme: |drawing

[ Hydro mech

— Tool control
Tools Action &Value [ Show all
die |velocity ||5000 | Trapezoid v |
punch W
hinder |F|:|rce ﬂ |EE+DEIS |Cun5tantﬂﬂ
— Duration

Type: |Cluaure

ﬂ [ Fully match

ﬂ |pun|:h

Taools: |die

j Gap: 0.0

— D3plat

Frames: (10

Advanced...

Subimit... |

Exit

Figure 5.72 Drawing process interface

Now, let’s add a new process for pun2.

1.

Click New stage button to display the new stage interface.

2. At the input data field of Name, type in drawing2 as the name of new

process. See Figure 5.73.

3. Verify the other settings are similar to those illustrated in Figure 5.72. Then,
press Apply button to create the new process.
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File Tools Preview Joh

Stages: — Mew stage
closing Marme: |drawing2
drawing
— Type of stage
Type of stage: |F|:|rming ﬂ
— Default setting
# Llse setting of stage: |drawing ﬂ

& Lse default setting

— Inser position

& Insert bhefore drawing ﬂ

#+ Insert after

ARply

Mew stage

Dielete stage

Submit... Exit

Figure 5.73 Define new process

4. Toggle on the Show all checkbox to display all tools, as illustrated in
Figure 5.74.

5. Set the movement of all tools stationary, except pun2. Set the velocity of
pun2 at 5000 (mm/s).

6. Next, select Closure as the type of duration. As shown in Figure 5.74,
pun2 is moving toward punch.
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File Tools Preview Job

General | Ellank| Tools | Process | Cnntrnl|

Stages: — Current stage
closing Marme: |drawing2
drawing ™ Hydra mech
drawing 2
— Tool control
Tools Action &Yalue [v Sho all
punch Stationamn w ﬂ
hinder Stationar, =
punz |"-.-"E|EII3it‘5.l' ﬂ|5EIEIEI |Trapeznidﬂ =
— Dwration
Type: | Closure w | [ Fully match
Tools: |pun2 ﬂ |pun|:h ﬂ Gap: |IZI.IZI
— D3plot
Frames: [10
Mew stage
Delete stage

Submit... Exit

Figure 5.74 Drawing?2 process definition

VIIl.  Animation

Prior to submitting a simulation job, you shall validate the process setting by
viewing the animation of tool movement. The procedure to conduct animation is
listed as the following:

1. Select Preview->Animation... in the menu bar. See Figure 5.75.

File Tools BREETE ob

Animation...

Summary..

Figure 5.75 Animation menu
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2. The animation of tool movement is shown on the display area.

3. You can select the INDIVIDUAL FRAMES option from the ANIMATE
dialog box illustrated in Figure 5.76 to display incremental tool movement.

¥ Individual Frarmes

4| «| »| >

25

FramesiSecond

Stop

Figure 5.76  Animate control dialog box

s ciic M | ]

step.

icon to displayS the tool movement step by

5. The time step and displacement of tools are printed on the upper left hand
corner of the display area. See Figure 5.77.

6. Click Exit button to return to the main interface.

STEP 17 TIME = 2.1264577E-802
DIE POSI = 55.477493
PUNCH POST = 0.000000
BINDER POSI = 6.000000
PUNZ POSI = Z2.812686
Figure 5.77 Animation of tool movement
Submit Job

After validating the tools movement, you may continue with submitting the stamping
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simulation through the steps listed below:

1. Select Job—=>Job Submitter... in the menu bar. See Figure 5.78.

File Tools Preview L]

L3-Dyna Input Eile...
Full Bun Dyna...

Job Submitter...

Figure 5.78 Job menu

2. The SUBMIT JOB dialog box illustrated in 5.79 is displayed.

— Dwna input file

File: |d:'ttraininglaingle_actinnlsingIe_actinn_weld.dyn
— Qption
v Specify job 1D |5ing|e_actiun_weld

¥ Specify memory (MBY: |4nn

Submit Cancel

Figure 5.79 Submit job dialog box

3. Click Submit button from the SUBMIT JOB dialog box to display the Job
Submitter interface illustrated in Figure 5.80.

4. Click Submit Jobs button, as shown in Figure 5.80 to activate the
LS-DYNA solver for running the stamping simulation. The LS-DYNA
solver window illustrated in Figure 5.81 is displayed and the simulation is in
progress.

190 eta/DYNAFORM Application Manual



Single Action - Tailor Welded Blank

EE&tafI.S—DYHA Jobs Submitter 3.0 — Personal

LS-Dvna ! MStep Solver: Caontrol Parameter

@ Single Precision |DJ/LSDYMARrogramilsdyna.exe | W Auto Memaony: ’W Tzl
<& Double Precision |DJ/LSDYMARrogramilsdyna.exe - | Pause between jobs: ,1— cac
< MStep Solver DoLSDYNAprogramiMStep. exe

SubmitJobs| Reset Johs |I

EIE: &8 vrelatglotal x| ¢ [+ [B] 2

Precision File Mame In Folder Size Type ]=] | Sec Status
single_action_weld d:Arainingrsingle_action_weldf A4k dyn Running

"l

1] |

GROUPT

Figure 5.80 Submit job interface

e LSDYNA — G:\Training\DF_TRA™1.DYN

total energy ~ initial energy.. 1_APOBBE+BA
energy ratio ws/o eroded energy. 1.A80BEE+BA
globhal x velocity B.ABBRBE+BA
glohal vy velocity 8. A0OBEE+BA
globhal =z velocity B.AARAE+BA

number of zhell elements that

reached the minimum time step..

cpu time per =zone cycle nanoseconds
average cpu time per =zone cycle.... B nanoseconds
average clock time per zone cycle.. 481714 nanoseconds

5
a

estimated total cpu time
estimated cpu time to complete
estimated total clock time
estimated clock time to complete

added maszs -H8HEE+08
percentage increase .ARBRE+AA

-BRABE+ABR dt 1 .32E-86 flush iso huffers

.BABPE+BA dt 1.32E-06 write d3Iplot file

.758BE-B4 dt 1.32E-0U6 write adaptivity stress file

.758BE-B84 dt 1.32E-B6 increase shells from 1758 to 2113

Figure 5.81 LS-DYNA solver window

When you submit a job from etay/DYNAFORM, an input deck is automatically
created. The input deck is adopted by the solver, LS-DYNA, to process the stamping
simulation. The default input deck names are single_action_weld.dyn and
single_action_weld.mod. In addition, an index file named single_action_weld.idx
is generated for the reference in eta/POST. The .dyn file contains all of the keyword
control cards, while the .mod file contains the geometry data and boundary
conditions. Advanced users are encouraged to study the .dyn input file. For more
information, refer to the LS-DYNA User’s Manual.
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Note: All files generated by either eta/DYNAFORM or LS-DYNA is stored in the
directory in which the eta/DYNAFORM database has been saved. You shall
ensure the folder doesn't include similar files prior to running the current job
because these files will be overwritten.
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII
data files such as glstat, rcforc, etc,. In addition to the undeformed model data, the

d3plot file also contains all result data generated by LS-DYNA (stress, strain, time
history data, deformation, etc.).

Refer to previous examples for information about processing forming result.
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DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5.

For workstation/Linux users, enter the command “df55” (default) from a UNIX shell.
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created. You begin
by importing FEA data files to the current database.

Import file

From the menu bar, select File=>Import to open the IMPORT FILE dialog box
illustrated in Figure 6.1. Next, Click the drop-down button of File Type and select
DYNAIN (*dynain*) Then, go to the training input files located in the CD
provided along with the eta/DYNAFORM installation. Locate the data file:
springback.dynain. After importing the file, the model is displayed in the screen,
as shown in Figure 6.2.
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Loak ir: |Bd}lnain ﬂ L] I'fF *

ku Recent
Dacuments

L

Dezktop

1.||

\$

My Documents

by Computer

My Metwork  File narne: |springl:uan:k.u:|_l,lnain j Ok |
Flaces
Files of type: |DYN.£‘-.IN [Fdwnain®] ﬂ Irnipart
[ AllFiles Cancel

Figure 6.1 Import file dialog box

Figure 6.2 Illustration of U-Channel

Save the database

Select File=Save as, input the filename “springback.df” in the specified working
directory, and then click the Save button to save the current database and exit the
dialog box.
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Save As

My Recent
Dlocuments

wll

by M etwork,
Flaces

2

Save if: | [ springback

x| « & cf E-

File name:

Save as type:

Ispringback

| database [*.df]

L] Save
=l

Cancel

Database Unit

Figure 6.3 Save as dialog box

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.
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AUTO SETUP

Prior to entering AUTOSETUP interface, upper/lower tool meshes are required. The
other operation can be carried out in AutoSetup interface, such as PHYSICAL
OFFSET of element, selection of CONTACT OFFSET. As illustrated in Figure 6.4,
you can select AUTOSETUP option from the SETUP menu to display the
AUTOSETUP interface.

File Parts Preprocess | DFE  BSE |[EEMEl Tools Option  Utiities  View

Gravity Loading
Diraw Die
Spring Back

AUtoSetup

Figure 6.4 AutoSetup menu

I. Creation of a New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog box, as
illustrated in Figure 6.5. You continue with defining basic parameters such as blank
thickness, type of process, etc from the dialog box.

New Simulation

— Simulation

Type: |Sheetfnrming ﬂ
— Process

Type: |5pringbacl{ ﬂ
— Sheet

Thickness: [1.00

Cancel

Figure 6.5 New simulation dialog
1. Select simulation type: Sheet forming;
2. Select process type: Springback;
3. Input blank thickness: 1.0 (mm);
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4. Click OK to display the main AUTOSETUP dialog box.

Il. General

After entering General interface, you need to change Title into Springback. Accept
other default values. See Figure 6.6.

Eile  Tools  Previews Jaob

General | Ellank| Frocess | Cartral |

— Title

Title: |5pringhack

—Working coordinate system
Qrigin:  §0, 0, 0

Glohal C5
U-faiss 1, 0000 e
VeRmiss (001, M Local C5..
W-dxis: (0, 0,1)

— Tool acceleration time

Acceleration time: |0.001

— Caomment

This iz a springhack training case.

Subrmit... Exit

Figure 6.6 General interface

1. Blank Definition
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1. Click the Blank tab in the AutoSetup interface to enter the blank definition page.
2. Click the Parts... button in Geometry field.

File Tools PFreview Job

| Process | Control |

Material Thickness FPropery

Mo defined geometry |

Figure 6.7 Define blank

3. Click Add Part...in the popped DEFINE GEOMETRY dialog box; select the
part of BLANK in the popped dialog box, and click OK to exit the selection.
Then, system will return to the Blank definition page.

4. Now, the basic parameters about the blank have been defined, and the tab of the
Blank has changed from red into blank. See Figure 6.8.

Eile  Tools Previews Jaohb

| Process | Control |

— Geometny

M aterial Thickness Froperty

. A we-s |
— Symimetry

Symimetry type: |N|:| symmetry Define ...

Figure 6.8 Blank definition interface

IV. Blank Material and Property Definition

Once blank has been defined, the program automatically selects a kind of default

material and relative property as shown Figure 6.8. You can also press BLANKMAT
button to redefine material.

Note: You must select the same material and thickness as forming simulation in
springback analysis.

1. Click BLANKMAT button to pop up the MATERIAL dialog box, following

by pressing the Material Library... button to select United States material
library.
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554 BLAMEMAT
Type: T36
Mame: BLAMKMAT 468
383
Mlewy... T Edit ...
288
[rpart... Export...
Material Library ...+ 212
IInited States _|
Japan 1327
“hina 17T 17 17T 1T 17T 1T T T 1
0.00 010 0.20 n.24 0349 0.44
_ Europe ||

Figure 6.9 Material dialog box

2. Select the material model and material in the material library. In this example,
you select mild steel DQSK. Then, return to the Blank definition interface.

3. Define property. Click NIP=5 button. A dialog box (as shown Figure 6.10) is
popped up. In the drop-down menu, select the fully integrated element
recommended in the LS-DYNA springback analysis, and set the Number of
Integration points as 7, then click OK to exit the dialog.

Property

— Property
|1E.FULLYINTEGRATED ﬂ

FHumber of Integration points: |T

Shear correction factor: |EI.833EIEIEI

Default | Cancel

Figure 6.10 Property dialog box

V. Process Definition

A default spring process is created in springback analysis. You are not allowed to add
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new processes. The relating parameters are setup as follows:

1. Define constraint nodes. Click Edit... button (shown in Figure 6.11) to define
constraint nodes. Select three nodes on the bottom of the U-channel.

Note: The selected nodes can’t lie in the same line, near the edge of the part and lie
in the region where the deformation is larger; and these nodes must be apart from
each other with some distance.

2. Select Coarsening option. It permits the solver to join the adjacent elements
according to a specified angle. Coarsened mesh can reduce the computing time
and instability during springback calculation. The default coarsening angle is 8°.

3. Select the solving algorithm. eta/DYNAFORM provides Single-step Implicit and
Multi-step Implicit algorithm, you select Multi-step Implicit algorithm in this
example.

Eile  Tools Preview Job

Stages: — Current stage

springback Mame: |5pringhack

— Constraint nodes

FHumber of nodes: |3 Edit ...

— Coarsening mesh

[v Coarsening Angle: (3.0

— Analysis

& Single-step implicit t multi-step implicit

Figure 6.11 springback process setup

Note: The parameters in Control interface is the recommended default parameters,
you may accept the default values. You can also refer to the eta/DYNAFORM
User’s Manual and LSDYNA KEYWORDS USER'S MENU for information
about all of the implicit parameter setup.

VI.  Submit Job
1. Select Job=>Full Run Dyna...in the menu bar. See Figure 6.12.
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Eile Taoaols Preview m

L5-Dwna Input Eile..

Full Bun Cyha...
Jaob Submitter..

Figure 6.12 Job Submitter menu
2. The SUBMIT JOB dialog box illustrated in Figure 6.13.

3. Click Submit button from the SUBMIT JOB dialog box to display the Job
Submitter interface. Now, the simulation is in progress.

— Solver

< Single precision 0 Douhkle precision

— Dwna input file

File: ditrainingspringbackispringback.dyn
— Dption
[ Specify job [D: springback

[ Specify memory (MB). 128

SR Cancel

Figure 6.13 Submit job dialog box
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII data
files such as glstat, rcforc, etc,. In addition to the undeformed model data, the d3plot
file also contains all result data generated by LS-DYNA (stress, strain, time history
data, deformation, etc.).

Reading d3plot file into the Post Processor

To run eta/POST, select the PostProcess in the eta/DYNAFORM main menu bar.
The default path for eta/POST is C:\Program Files\Dynaform 5.5. In this directory,
double-click the icon of EtaPostProcessor.exe to run eta/POST, or select
DYNAFORMS5.5 in start menu. The GUI of eta/POST is shown in Figure 6.15.

File Parts Preprngess‘QFE §8E|§etup Tools Option  Utilities  Wiew 5na|ysistPostProcess) Help

Figure 6.14 PostProcess menu

A D A g\sp gha p ghack. d3plo =e
Eile Edit Tool Option Help
= 4 s eigitalGls] o QT Sie@e] s -9 0o/ & b
N5 651
olEe
i
Scale Factor IW—

Frames

Fram 1 H Ink 1

» n =] &

H 41 » H
Frame Number
Frames/Second
-_—

ETA/POST

#COMMAND COMPLETED
#PART ATTRIBUTES
SELECT BY CURSOR T Fill Color [ Element Edge [ Shrink
PRESS EXIT

#COMMAND COMPLETED
Ready

¥ Shade ¥ 8maooth Shade [ Material Colar

Lal |

<1| ™ Hidden Surface [~ Plate Mormal I~ Background

Figure 6.15 Post process GUI

1. Select File=Open in the eta/POST menu bar. The SELECT FILE dialog box is
illustrated in Figure 6.16.
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Loak in |D:Rtraining\springbacm v ﬂﬂ

springback.d3plaot §

File Mame: |springhack.d3plot Open |

File Type: |LS-DYI‘~JA Fost( d3plot, d3drlf, dynain, d3plotaa, « © Cancel

Figure 6.16 Select File dialog box

2. Select the result files (including d3plot, d3drlf, dynain) from the file list.

3. Browse the directory where the result files are saved and select the correct file
format, and then press the Open tab to read d3plot file. You can analyze and
process the results through various operations provided by the eta/POST.
Figure.6.17 shows the standard icon for springback analysis.

0| 7| &|&| k|

Figure 6.17 Standard icon for springback analysis

Il.  Springback analysis

1. Observe the springback change in the post process. There only are two frames in
the file of d3plot. Figure 6.18 shows the blank shape before springback and after
springback.
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z

<

2. To better view the springback result, you can create a section line along the part.
Select menu Tool=Section Cut, as shown in Figure 6.19.

=

(a) (b)
Figure 6.18 Springback results (a) before (b) after

File Edit Option  Help

Section Cut
Constrain Maotion
Mirrar Result by =L

Face Reflaction
Define Active Window
Clear Active Window
Defire Mage ™ are

Figure 6.19 Section Cut menu

3. Click Define Cut Plane in the right dialog box, as shown in Figure 6.20a. A
Control Option dialog box is popped up, as shown in Figure 6.20b.

4. Select W Along +Y Axis, pick two nodes in the part, as shown in Figure 6.21.

5. Click Exit, and press Accept in the popped dialog box. Then a section line is
created automatically, as shown in Figure 6.22.

6. Click Apply in the popped dialog box, and press the play button in the
deformable window, then a clear springback can be observed in that section.

7. You can use the tool provided in post process to measure the dimensions before
and after springback, so that obtain the detail springback values. Click the icon

B srich et - ek the icons P4 ang
which set view as X-Z view, then click the icons and to
measure the dimensions before and after springback. Figure 6.23 shows the
results.
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Section anly % Caontrol Qption

il
i

Figure 6.21 pick twolnodes Figure 6.22 the created section line
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Y

= 77.57 o
\_ RS . \

46.53
40 30.4

l '\(/R4

a) before springback b) after springback
Figure 6.23 section dimensions before and after springback
Note: For the complex part, the springback varies for different location. Therefore,
you should pick a serial of section lines in different location to better analyze
springback result. In this example, the general method of analysis springback
isgiven.

8. Other methods can be used to analysis springback. For example, you can import
the dynain files before and after springback. This is because they lie in the same
coordinate system, two section lines can be created by making them intersect the
identity section, therefore, you can observe the change before and after
springback conveniently.

Il.  Summary

This example introduces the general process of springback analysis by using
AutoSetup. Springback analysis is different than forming analysis. It is carried out
using the implicit method, which may cause convergence problems. We recommend
you to use dynain file to perform springback analysis. Refer to the eta/DYNAFORM
and LS-DYNA User’s Manual for detail information about setup of implicit
parameters in springback analysis.
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Example 7. Sheet Metal Hydro-forming
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DATABASE MANIPULATION

Creating an eta/DYNAFORM Database and Analysis Setup

Start eta/DYNAFORM 5.5.

For workstation/Linux users, enter the command “df55” (default) from a UNIX shell.
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created. You begin

by opening the existing database.

Open the database

1. From the menu bar, select File=>Open... to open the OPEN FILE dialog box

illustrated in Figure 7.1.

Open @
Look in: [ of -] £ B
) Double_ackion_bydro.df
3 gravity_|oading. df
My Recent single_action. df
Documents
T
Deszktop
by Documentz
by Computer
My Metwark  File name: |D|:.u|:||e_a|:ti|:-n_h_l,'dr-:u.df ﬂ Elpen_l
Flaces
Files af twpe: | databasze [*.df] ﬂ Cancel

Figure 7.1  Open file dialog box
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2. Go to the training input files located in the CD provided along with the
eta/DYNAFORM installation, and open the data file named

Double_action_hydro.df. The model illustrated in Figure 7.2 is displayed in
the display area.

Figure 7.2 Illustration of model in Exercise 7

Note: The Icons bar may appear different depending on type of platform. Other
functions on the Toolbar are further discussed in next section. You can also
refer to the eta/DYNAFORM User’s Manual for information about the
Toolbar functions.

Database Unit

From the menu bar, select Tools=>Analysis Setup. The default unit system for a new
eta/DYNAFORM database is mm, Newton, second, and Ton.
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AUTO SETUP

Prior to entering AUTOSETUP interface, upper/lower tool meshes are required. The
other operation can be carried out in AutoSetup interface, such as PHYSICAL
OFFSET of element, selection of CONTACT OFFSET. As illustrated in Figure 7.3,
you can select AUTOSETUP option from the SETUP menu to display the
AUTOSETUP interface.

Tools Option  Utilities  Wiew .

File Parts Preprocess | DFE  BsE

Gravity Loading
Draw Die
Spring Back

AltoSsetup

Figure 7.3 Setup menu

I.  New Simulation

Click AutoSetup in the menu bar to display the NEW SIMULATION dialog box
illustrated in Figure 7.4. You continue with defining basic parameters such as blank
thickness, type of process, etc from the dialog box.

New S5imulation

— Simulation

Type: |5heetf|:|rming ﬂ
— Process

Type: |D|:|uble action ﬂ
— Sheet

Thickness: |1.nn

— Blank surface

< Top < Bottom < hiddle

] Cancel

Figure 7.4 New simulation dialog box

1. Select simulation type: Sheet forming.
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Select process type: Double Action.
Input blank thickness: 1.0 (mm).

Select tools reference: Dual.

o w

Click OK to display the main AUTOSETUP dialog box.

Il. General

After entering General interface, you do not need to modify any parameters except
for typing in double_action_hydro in the input data field of Title. In addition, you
can type in some comments about the setting/process in the Comment input field
illustrated in Figure 7.5.
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File  Tools Preview Joh

General | Ellanl-:| Tools | Frocess | Control |

— Title

Title: |dnub|e_actinn_hydm

—Working coordinate system
Qrigin: (0, 0, M

Glohal CS
vais om0 et
Welxiso (0,1, 00 Local &5,
Wi-Axis: (0,0,1)

— Toal aceeleration time

Acceleration time: |0.001

— Comment

Submit... Exit

Figure 7.5 General interface

I11. Blank Definition

1. Use your mouse cursor to click on Blank tab to display the blank definition
interface.

2. Then, click Parts... button from Geometry field in blank definition interface.
See Figure 7.6.
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Geometry

FPars... Material Thickness Froperty

Mo defined geometry !

Figure 7.6  Define blank

3. The DEFINE GEOEMTRY dialog box illustrated in Figure 7.7 is displayed.

Define geometry

— Parts

t Add Part ... i| Remove Part

Add Elerm ... Coaopy Elerm ... |

Split part |

Display Exit

Figure 7.7 Define geometry dialog box

4. Click Add Part... button. Use your mouse cursor to select BLANK part
from the SELECT PART dialog box illustrated in Figure 7.8.

eta/DYNAFORM Application Manual 215



Sheet Metal Hydro-forming

Select by Cursar

7]
pi|

Select by Mame

[ Exclude
Total selected 1
Displayed All Parts

Reject Last Part

0] Cancel

Figure 7.8  Select part dialog box

5. After selecting the part, click on OK button to return to the DEFINE
GEOMETRY dialog box. The BLANK part is added to the list. See Figure

7.9.

— Parts
[ Add Part | Remove Part|
Add Elem | Copy Elerm |
Split part |
Display | Ext |

Figure 7.9 Blank geometry list

216 eta/DYNAFORM Application Manual



Sheet Metal Hydro-forming

6. Click the Exit button to return to the blank definition interface. Now, the
color of Blank tab is changed to from RED to BLACK. See figure 7.10.

Eile  Tools  Previews Jaob

| Tools | Frocess | Contral |

— Geoametry
FPars... | hiaterial Thickness Property
N oo [0 wes
— Symimetrny
Symmetry type: |N|:| symmetry Cefine ...

Subrmit... Exit

Figure 7.10 Blank definition interface

IV. Blank Material and Property Definition

Once the BLANK part is defined, the program automatically assigns a default blank
material and relative property. You can also press the BLANKMAT button illustrated
in Figure 7.11 to edit material definition.
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Geametry

Farts... material Thickness Property

_ BLAMKMAT | 1.00 MIP=5

Figure 7.11 Blank definition

After clicking the BLANKMAT button, the MATERIAL dialog box illustrated in
Figure 1.13 is displayed. You can create, edit or import material into the database.
Moreover, you can press the Material Library... button to select generic material
database provided by eta/DYNAFORM. Click on the Material Library... button
to select the United States material library illustrated in Figure 7.12.

554 BLAMEMAT
Type: T36
Mame: BLAMKMAT 468
383
Mlewy... T Edit ...
288
[rpart... Export...
Material Library ...+ 212
IInited States _|
Japan 1327
“hina 17T 17 17T 1T 17T 1T T T 1
0.00 010 0.20 n.24 0349 0.44
_ Europe ||

Figure 7.12 Material dialog box

Now, you continue to select a material from the material library, as shown in Figure
7.13.
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Naterial Library

Material Type  Strength Level Material Hame T1 T18 T24 T36 T37 T39 T64

Ci
hiled [nlm}

+ |+ [+

DSk

|

O ) T R R VR A ) N Wiy S

BH180
Medium BH210
BH2:50

HELA250
High HELAS00
HSLAS50

+ ||+ |+ [+
Lo LD o0 e el L I»

=TEEL DRS00
Advanced High  DPSOo0

EO A O S A O A S S S
+ =+
+ [+ [+

o S (O S A A S

Ci
Hat Rolled DSk,

DDaIF

Ly [« [»

SECrCh
Stainless SEA BCHCR
55304

AR5 G2
AB5454
SASTS

L R=Ca 1Ty

L L«

ALLIRAIMUR

F N E ET N EA T S SR S
N N R N A T EA SR SR A8
e N N N E o S S SR SR P8
F N E ET N EA T S SR S
e N N N E o S S SR SR P8

L

Edit library .. | Exit

Figure 7.13 United States generic material library

V. Tool Definition
1. Click on Tools tab to display tool definition interface.

|
2. Click QJ icon from the Icon bar, and turn off the BLANK part.

3. Based on the defined process, three standard tools: die, punch and binder, are
listed at the left side of the tool definition interface. You can continue with
definition of each tool. By default, the punch interface is displayed.

4. Press the Parts... button to assign a part as punch. See Figure 7.14.
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Toals: — Surrent toal

- Mame: |punch
die
Parts Parts... I

Mo defined geometny |

hinder - e,

Figure 7.14  Punch definition

5. The DEFINE GEOMETRY dialog box illustrated in Figure 7.15 is displayed.
Next, click the Add Part... button in the dialog box.

Define geometry

— Parts

‘ Remaove Part |

Add Elem .. | Copy Elem |

Guide / Pin |

Display | Exit |

Figure 7.15 Define geometry dialog box

6. Select PUNCH part from the SELECT PART dialog box illustrated in Figure
7.16.

220 eta/DYNAFORM Application Manual



Sheet Metal Hydro-forming

Select Part

Select by Cursar

A &
5

Select by Mame

[ Exclude
Total selected 1]
Displayed All Parts

Reject Last Part

0] Cancel

Figure 7.16 Select part dialog box

7. Click OK button to return to the DEFINE GEOMETRY dialog box. The
PUNCH part is added to the list. See Figure 7.17.

Define geometry

— Parts

| Femaove F'art|

Add Elem | Copy Elerm |

Guide { Pin |

Display | Ext |

Figure 7.17 Punch geometry list

8. Click Exit button to return to tool definition interface. Now, you can observe
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the font color of die is changed to BLACK. See Figure 7.18.

Toals: — Zurrent tool
punch .| Mame: |punch
me ...........................

hinder [ (CeumiEy

Farts Parts...

Figure 7.18 Punch definition interface

9. Click die located at the left side of tools list to display die definition
interface.

10. Click the Parts... button to display the DEFINE GEOMETRY dialog box.

11. Click Copy Elem... button to display COPY ELEMENTS dialog box
illustrated in Figure 7.19.

12. Next, toggle on the checkbox of Offset elements option. Then, click on the
Select... button to display the SELECT ELEMENTS dialog box illustrated in
Figure 7.20.

13. Toggle on Select By option in the dialog box. Then, press the Unspecified
button to select PUNCH from the SELECT PART dialog box.

14. Click on the Done button to accept selection.

15. Again, press the Unspecified button to select BINDER from the SELECT
PART dialog box.

16. Click on the Done button to accept selection.

Copy elements

IF Offset elements

Thickness : |1.1

Elements :

0
Clear Select ...

Apply Undo Exit

Figure 7.19 Copy elements dialog box

222 eta/DYNAFORM Application Manual



Sheet Metal Hydro-forming

Select Elements

v Select By Cursar

AN

I

3

& s

Angle
[ Select By Part -
Mame Unspecified
Done

Displayed All Elements
[ Filter Filter Type
[~ Exclude
Taotal Selected ]

Reject Last Selection |

Ok

Cancel |

Figure 7.20  Select elements dialog box

17. Click OK button to accept the element selections and dismiss the SELECT
ELEMENTS dialog box.

18. Click Apply button in the COPY ELEMENTS dialog box to offset elements,
following by clicking the Exit button. All created elements are automatically
added to a new part named OFFSETOO, and the part is added to the list of
Die. See Figure 7.21.
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19.

20.

21.
22,

23.

24,

Define geometry

— Parts

Remove Part

Add Elem ... | Copy Elem ...

Guide / Pin

Display Exit

Figure 7.21  Die geometry list

From the DEFINE GEOEMTRY dialog box, click Exit button to return to
tool definition interface. Now, the tag color of all tools is changed red into
black. It means all tools have been defined. See figure 7.22.

Tools: — Current tool
punch Mame: |die
binder — Geometry

Farts Parts... |

Figure 7.22 Die definition interface

Click binder located at the left side of tools list to display die definition
interface.

Click the Parts... button to display the DEFINE GEOMETRY dialog box.

The DEFINE GEOMETRY dialog box illustrated in Figure 7.15 is displayed.
Next, click the Add Part... button in the dialog box.

Select BINDER part from the SELECT PART dialog box illustrated in
Figure 7.23.

Click OK button to return to the DEFINE GEOMETRY dialog box. The
BINDER part is added to the list. See Figure 7.24.
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25. Click Exit button to return to tool definition interface. Now, you can observe
the font color of binder is changed to BLACK. See Figure 7.25.

Select by Cursor

A &
pu

Select by Mame

[ Exclude
Total selected 0
Displayed | Al Parts
Reject Last Part |
K | Cancel |

Figure 7.23  Select part dialog box

Define geometry

— Parts

Remaove Part

Add Elem ... | Copy Elem ...

Guide ! Pin

Display Exit

Figure 7.24  Binder geometry list
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Toals: — Current tool
punch Mame: [binder

die

— Geometry

Farts Parts...

Figure 7.25 Binder definition interface

V1. Drawbead Definition

1. Select Tools->Drawbeads... from the AutoSetup menu bar. See Figure 7.26.

Eile

Previesy Job

Display...
Home...
Positioning...

Drawhbeads. ..

FPoplines...

Figure 7.26  Tools menu

2. Then, click New button to create a new Drawbead property. See Figure
7.27.

3. The DRAWBEAD PROPERTIES window illustrated in Figure 7.28 is
displayed.

4. Click OK button to accept the default parameters.

Drawbhead

W Show Drawhead
[ Drawbead color by property
v Show Modes

Drawbead Properties

Cniew || modity | Detete |
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Figure 7.27 Drawbead dialog box

DEAY BEAD PROPERTIES

SECTION TITLE oead

STATIC FRICTION COEF. [ ooooooE-o1
DVNAMIC FRICTION COEF. [ 000000E-+000

BENDING LOAD CURVE D -

M Full Lock Farce [4 2780008 +002 Default

DRAW BEAD DEPTH [ D00000E+000
BENDING CURVE SCALE TR
Advanced | Defaut |  Reset Cancel

Figure 7.28 Drawbead properties window

5. As illustrated in Figure 7.29, a new drawbead property named beadl is added
to the list.

Drawhead

W Show Drasvwbead
[ Drawhbead colar by property
v Show Modes

Drawhead Properties

New | wlndiﬁ.r| Delete|

Fig.ure 7.29 Draw bead properties list

6. Now, you continue to assign a drawbead line. Since no drawbead line is
provided in the database, you have to create the line using the function
provided in the LINE/POINT dialog box.

7. Click OK button in the DRAWBEAD dialog box, following by clicking Exit
button in the main interface to close the AUTOSETUP window.

8. From the menu bar, select Preprocess->Line/Point to display the
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LINE/POINT dialog box illustrated in Figure 7.30. Then, press the Offset

icon.

10| A ¥

= e A

=l MR | R

N I P e

| gi] 2|
ox |

Figure 7.30 Offset a curve

9. Next, use your mouse cursor to select the line highlighted in Figure 7.30.
Then, click OK button to define the coordinate system, following by clicking
Yes button to accept the default LCS.

10. Type in 50 (mm) in the OFFSET DISTANCE dialog box illustrated in Figure
7.31.

OFFSET DISTANCE

Figure 7.31 Offset distance dialog box
11. Click OK button to accept the input offset distance.

12. Select No in the pop-up dialog box illustrated in Figure 7.32.

Dynaform Question

|5 offset direction acceptable?

...........................

Yes i Mo

...........................

Figure 7.32 eta/DYNAFORM Question dialog box

13. Click OK button to dismiss the LINE/POINT dialog box.
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14. Click on ‘ E' icon from the Icon bar to save the database.

15. Again, open the DRAWBEAD dialog box in the AUTOSETUP interface.
Press New button to create a new drawbead. See Figure7.30.

Drawbeads

Full Lock % | 100 Applﬁf|

[ SelectAll [ List by Froperty

[ e Caonstruct

Assign Prop Respace

Trirm Combine

Delete Split

[ Drawbead Box
Box Size |20.00  Apply

Showe Box

Lock an: _ J

)4

Figure 7.33 Create new drawbead

16. Use your mouse cursor to pick the highlighted drawbead line illustrated in
Figure 7.34. The DRAWBEAD INPUT dialog box is displayed.

17. Click OK button to accept the default setting in DRAWBEAD INPUT dialog
box.
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Drawhead Input

I_ By Distance |2EI.IZIIZIEI

[v Linifarm 20
[ Chordal Deviation |0.2500

Max Length |20 000

)8 | Cancel |

Figure 7.34 Drawbead parameters setting
18. The new drawbead named Drawbeadl is added to the list.

19. Next, use your mouse cursor to pick Drawbeadl from the drawbead list.
Type in 20 (%) in the input data field of Full Lock % illustrated in Figure
7.35. Then, click Apply button to modify the full lock force of drawbead.

Crawheads
DrawBead 1| bead]

Full Lock %| 20 Apply |

Figure 7.35 Drawbead list

20. Click J button illustrated in Figure 7.33 to lock drawbead to BINDER.
Select BINDER from the SELECT PART dialog box.

21. The eta/DYNAFORM Question dialog box illustrated in Figure 7.36 is
displayed. Select Yes to accept the projection.

22. Click OK button to dismiss the DRAWBEAD dialog box.

[ Drawvhead Box

Box Size Apply
Dynaform Question

Lock ar: _ J Ok to project drawheads to the rigid part?

Ok | es

Figure 7.36  Lock the drawbead
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VI1. Tools Positioning

After defining all tools, the user needs to position the relative position of tools for the
stamping operation. The tool positioning operation must be carried out each time the
user sets up a stamping simulation model. Otherwise, the user may not obtain correct
stamping simulation setup.

The tool position is related to the working direction of each tool. Therefore, you need
to carefully check the working direction prior to positioning the tools. If the process
template is chosen, the default working direction is selected. You can also define
special working direction.

1. Click Positioning... button located at the lower right corner of the tool
definition interface to display the POSITIONING dialog box illustrated in
Figure 7.37. Alternatively, you can select Tools->Positioning... from the

menu bar.

— Blank
Translation; |0
— Toaol
Tools mMovement

punch 0
die n
hinder 0

— Auto-position
Fixed: |die ﬂ
W Round off Auto

! Reset ! Ik, | Cancel |

Figure 7.37 Before tool positioning

2. Select die as fixed tool and use it as the reference tool. The tool is stationary
during automatic positioning.
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3. Click Auto button to position all tools and blank automatically. See Figure
7.38.

4. Now, all tools and blank are moved to a preset location. The movement of
each tool is listed in the input data field of corresponding tool. The value is
the measurement from the home/final position to the current position.

— Blank
Translation: |-54
— Tool
Tools Maovement
y - N\

punch - 122
die 0

hinder -23

— Auto-position

Fixed: ||:Iie ﬂ

W Round off | Auto

Reset| ] | Cancel

Figure 7.38  After tool auto positioning

5. Toggle off the checkbox of Lines and Surfaces in Display Options located
at the lower right corner of the screen. See Figure 7.39.

Current Part : LOWTOQOL Reset

[ Lines [~ Shrink [~ Hidden
[ Surface [ Mormal [ Fill Color
¥ Elements W Modes [~ Shade

Figure 7.39 Display option

6. Click Iﬁlﬂ

and @ icon from the lIcon bar to display the relative

position of tools and blank, as shown in Figure 7.40.
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7. Click OK button to save the current position of tools and blank, and return to
the tool definition interface.

e
=
i
T

- -J"":
o,
3

Figure 7.40 The relative position of tools and blank after positioning

Note: After autopositioning, the relative position of tools and blanks is displayed on
the screen. However, you may select Tools-Positioning... from the Auto
Setup menu bar, following by pressing the Reset button in the POS TIONING
dialog box to set the tools and blank(s) back to its original position. Moreover,
you can move the tools using the Home... function provided in the Tools
menu.

Now, you can continue with the next process which is definition of process
parameters. In Auto Setup application, the definition and positioning of blank(s) and
tools and definition of process are not required in strict order. Therefore, you can
randomly modify each operation. However, you are recommended to accordingly set
up the blank(s) definition, tools definition and process parameters.

VIIIl. Process Definition

The Process definition is utilized to set up process parameters of the current
simulation such as time required for every process, tooling speed, binder force and
so on. The parameters listed in process definition interface depend on the
pre-selected process template, including type of simulation and process.

In this example, the type of simulation and process is Sheet Forming and Double
Action, respectively. Therefore, two default processes are listed in the process
definition interface: closing and drawing process.

You can press Process tab of the main interface to enter process definition interface.
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Next, follow the steps listed below:

1. Select closing process from the list located at left side of the process
definition interface as the current process. See Figure 7.41.

2. Verify the default setting of closing stage is similar to Figure 7.41.

Eile  Tools  Previews Jaob

General | Ellank| Toals |iF 5i| Cantral |
Stages: — Current stage
closing Marme: |closing
drawing [ Hydro mech
— Tool control
Tools Artion & Value [ Show all
die |5tatinnary -
hinder |Ue|n|:it'g.r ﬂ |2EIEIEI |Trapeznidﬂ
— Duration
Type: |Clnaure ﬂ v Fully match
Tools: |hinder ﬂ|die ﬂ Gap: (0.0
— D3plot
Frames: |5 Advanced...

MHew stage

Delete stage

Subrmit... Exit

Figure 7.41 Closing process interface

3. Select drawing process from the list located at left side of the process
definition interface as current process.

4. Next, toggle on checkbox of Hydro mech option, as shown in Figure 7.42.
Click the drop-down button of Hydro mech option to select Below option,
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indicating the fluid pressure is applied from the bottom of blank.

Stages:

closing

drawing

Current stage

MHame: |drawing

W Hydro mech |Eleluw ﬂ

Figure 7.42 Hydro mech option

5. From Tool control field illustrated in Figure 7.43, click the drop-down button
of punch to select Variable option. Then, click Define... button to display the
LOAD CURVE/TIME dialog box illustrated in Figure 7.44.

— Tool control
Tools Action & Value [ Show all
punch W Cefine... ”m
die | stationary |
binder |Fnr|::e ﬂ |29+l2|l2|5 |Cnnstantﬂ ﬂ

Figure 7.43  Tool control

Load Curve/Time

a5 o # o[ e . =
J‘-i' 2| 'J" =2 :) £ 1f: @’ q @
e 2 Y OP: Mene Curzor: (0.05018, 700} Point:
1 0.0000 0.0000 c000
2  |0.0200 |0.0000 B
3 |0.0210 5000 =
4 0.0500 5000 i
4000_7
5 0.0510 0.0000 B
30005
2000_3
Add Insert _f
Delete Delete Al e
Apply =
| 0.0 3 .
mport Curve | Export Curve | T T[T T [ TO T [T 0T [T T[T [T T T[T I T[T I T [ToTT ]
0.0 0.m 0.0z 0.03 0.04 0.03
oK | Cancel |

Figure 7.44  Punch load curve definition

6. Use functions provided in Input page to key in the punch load curve
illustrated in Figure 7.44.
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7. Now, let’s continue to define the internal fluid pressure for sheet
hydroforming process. Click the No pressure button illustrated in Figure
7.45.

Hydro mech
|7F'resaure: Mo pressure flask: Entire

Figure 7.45 Fluid pressure for sheet hydroforming process

8. Select Time variable option as pressure control in HYDRO MECH dialog
box illustrated in Figure 7.46.

9. Click the Edit... button to display the LOAD CURVE/TIME dialog box.

10. Use functions provided in Input page to key in the pressure load curve
illustrated in Figure 7.47.

11. Click OK button to dismiss the LOAD CURVE/TIME dialog box and
complete the definition of internal pressure load curve. You observe the No
pressure button is switched to Variable P button illustrated in Figure 7.48.

— Pressure control

Pressure: Edit .
Cyle: 200
0] | Cancel |

Figure 7.46 Hydro mech dialog box
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Load Curve/Time

Input| Formula| Operation | Clipboardl ﬂ‘“.. i]_ <@>. Q {@]
No. X ¥ OP: None Curzor: (0.04852, 2.192) Point:

1 0.0000 0.0000 ’
2 |[0.0100 1.0000 E
3  |0.0200 2.0000 —
4 |00300 [2.0000 18 3
5 |0.0500 |1.0000 =
6 [0.0600 [1.0000 . E
1 3
06 7
Add Insert 3
Delete Delete All =
Apply e —:

3 t

EXDOHCUNE | - IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|
0005  0.005 0.015 0.025 0.035 0.045 0.055 0.065
Cancel |

Figure 7.47 Internal pressure load curve definition

Hydro mech

Fressure: ‘Variable P Mask Entire

Figure 7.488 Internal pressure definition

12. Click on the Entire button illustrated in Figure 7.48 to defined the boundary
of blank area subjected to applied internal fluid pressure.

13. The MASK dialog box illustrated in Figure 7.49 is displayed. Verify the

Inside option is selected. In addition, the direction of projection is in positive
dz.
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— Options

elnside | o Outside

— Direction
dx
dy:
dz 1

Froject Direction ...

— Loaop
Foints: 0
[mput Lns ... | Input Pts ... |
Clear
Ok | Zancel |

Figure 7.49 Internal pressure definition

14. Click on Input Lns button to define the boundary of mask using functions
provided in SELECT LINE dialog box. Select the highlighted line illustrated
in Figure 7.30, following by clicking OK button twice to return to process
definition interface.

15. At Duration field illustrated in Figure 7.50, type in 0.051 (s) in the input data

field of Time.
Duration
Type: |Time ﬂ
Time: [0.051

Figure 7.50 Duration of process

16. All process definition is complete. You can select Preview—=>Summary to
review the summary of simulation setup.
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IX. Animation

Prior to submitting a simulation job, you shall validate the process setting by viewing
the animation of tool movement. The procedure to conduct animation is listed as the
following:

1. Select Preview->Animation... in the menu bar. See Figure 7.51.

File  Tools Joh

Animation. ..

summany...

Figure 7.51 Animation menu
2. The animation of tool movement is shown on the display area.
3. You can select the INDIVIDUAL FRAMES option from the ANIMATE

dialog box to display the incremental tool movement.

4. Click M ] > ] display the tool movement step by step.

5. The time step and displacement of tools are printed on the upper left hand
corner of the display area.

6. Click Exit button to return the main interface.

X. Submit Job

After validating the tools movement, you may continue with submitting the stamping
simulation through the steps listed below:

1. Click Job->Job Submitter... in the menu bar. See Figure 7.52.

Eile Tools Preview [l

L3-Dyna Input Eile...
Full Bun Dyna...

Figure 7.52  Job Submitter menu

2. The SUBMIT JOB dialog box illustrated in Figure 7.53 is displayed.
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— Salwer

¢ Single precision & Diouble precizion

— Dvna input file

File: dMraininodouble_action_hydro.dyn

— Optian
[ Specify job D

[ Specify memaory (MB):

Skt Cancel|

Figure 7.53  Submit job dialog box

3. Click Submit button from the SUBMIT JOB dialog box to display the Job
Submitter interface.

4. Click Submit Jobs button to activate the LS-DYNA solver window
illustrated in Figure 7.54. The simulation is in progress.

LSDYNA — G:\Training\DF_TRA™1.DYN

total energy ~ initial energy.. 1. APABRE +0@
energy ratio w/o eroded energy. 1.8000HE +B8
glohal x velocity B.ARABRE +AA
glohal v velocity 0. 0HBEE +B8
glohal =z velocity B. AAAPE +AA

number of shell elements that

reached the minimum time step..

cpu time per zone cycle nanoseconds
average cpu time per zone cycle.... B nanoseconds
average clock time per =zone cycle.. 401714 nanoseconds

5
a

A hrs 8
B hes 8
1 hers 37
1 hes 37

estimated total cpu time
estimated cpu time to complete
estimated total clock time
estimated clock time to complete

nononon
oo
a0

1]
L]
N

W oMW

o
1}

added maszs 8. 8008E +88
percentage increase B . ABBRE+BB

A.00AAE+A8 dt 1.32E-86 fluzsh i~ o buffers

B.00EBE+BA dt 1.3Z2E-86 write d3plot file

2.7588E-84 dt 1.32E-@b write adaptivity stress file
2.7588E-84 dt 1.32E-B6 increase shells from 1758 to 2113

1t
1t
287 t
287 t

Figure 7.54 LS-DYNA solver window
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When you submit a job from eta/DYNAFORM, an input deck is automatically created.
The input deck is adopted by the solver, LS-DYNA, to process the stamping
simulation. The default input deck names are double action_hydro.dyn and
double_action_hydro.mod. In addition, an index file named
double_action_hydro.idx is generated for the reference in eta/POST. The .dyn file
contains all of the keyword control cards, while the .mod file contains the geometry
data and boundary conditions. Advanced users are encouraged to study the .dyn input
file. For more information, refer to the LS-DYNA User’s Manual.

Note: All files generated by either eta/DYNAFORM or LS-DYNA is stored in the
directory in which the eta/DYNAFORM database has been saved. You shall
ensure the folder doesn't include similar files prior to running the current job
because these files will be overwritten.
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot and ASCII data
files such as glstat, rcforc, etc,. In addition to the undeformed model data, the d3plot
file also contains all result data generated by LS-DYNA (stress, strain, time history
data, deformation, etc.).

Refer to previous examples for information about processing the result files.
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MORE ABOUT eta/DYNAFORM 5.5

Inside the eta/DYNAFORM 5.5 installation directory in PC, there is a file
named .DyanformDefault which controls key default parameters. Advanced users
may edit these default parameters to customize the program.

For Unix/Linux users, the .DynaformDefault file is located under both the
installation directory and the user’s home directory. The .DynaformDefault file
located under the installation directory will take precedence over the one located in
the user home directory.
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CONCLUSION

This concludes the training guide’s basic overview of eta/DYNAFORM 5.5. This
manual is meant to give you a basic understanding of finite element modeling for
forming analysis, as well as displaying the forming results. It is by no means an
extensive study of the simulation techniques and capabilities of eta/DYNAFORM.
For more detailed study of eta/DYNAFORM, you are urged to attend a
eta/DYNAFORM training session.

Please refer to the eta/DYNAFORM, eta/POST and the LS-DYNA User’s Manuals
for detailed description of individual functions and analysis settings.
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